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Introduction

Epilepsy is a chronic disorder of the brain that affects 
people worldwide. As per WHO, epilepsy is characterized by 
recurrent seizures, which are brief episodes of involuntary 
movement that may involve a part of the body (partial) or the 
entire body (generalized), and are sometimes accompanied 
by loss of consciousness and control of bowel or bladder 
function [1].

Epilepsy was one of the first brain disorders to be 
described. It was mentioned in ancient Babylon more 
than 3,000 years ago. The strange behaviour caused by 
some seizures has contributed through the ages to many 
superstitions and prejudices. From greek word attack, 
the word epilepsy is derived. In earlier times, People once 
thought that those with epilepsy were being visited by 
demons or gods. However, in 400 B.C., the early physician 
Hippocrates suggested that epilepsy was a disorder of the 
brain, and we now know that he was right [2].

Epilepsy is a major neurological disorder and upto 5% of 
the world population develops epilepsy in their lifetime. The 
current therapy of epilepsy with modern antiepileptic drugs 
is associated with side effects, dose-related and chronic 
toxicity as well as teratogenic effects and approximately 
30% of the patients continue to have seizures with current 
antiepileptic drug therapy. 

Traditional systems of medicines are popular in 
developing countries and upto 80% of the population relies 
on traditional medicines/ folk remedies for their primary 
health care need. Hence, there is a need to discover an 

alternative agent from natural sources [3].

Statement of The Problem 

More than 2 million people in the United States have 
experienced an unprovoked seizure or been diagnosed 
with epilepsy. For about 80 percent of those diagnosed with 
epilepsy, seizures can be controlled with modern medicines 
and surgical techniques. However, about 25 to 30 % of people 
with epilepsy will continue to suffer from seizures with 
the current available treatment. Doctors call this situation 
intractable epilepsy. Having a seizure does not necessarily 
mean that a person has epilepsy. Only when a person has had 
two or more seizures is he or she considered to have epilepsy 
[2].

Approximately 50 million people currently live with 
epilepsy worldwide. An estimate shows that people suffering 
from epilepsy (i.e. continuing seizures or with the need for 
treatment) at a given time is between 4 and 10 per 1000 
people. However, some studies shows that the proportion is 
much higher in low- and middle-income countries, between 
7 and 14 per 1000 people. 

Globally, each year epilepsy was diagnosed on estimating 
2.4 million people. In high-income countries, annual new 
cases are between 30 and 50 per 100 000 people in the 
general population. This figure can be up to two times higher 
in low- and middle-income countries. 

Various factors such as higher incidence of road 
traffic injuries, birth-related injuries, variations in 
medical infrastructure, availability of preventative health 
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programmes and awareness among people can be the reason 
for these. Close to 80% of people with epilepsy live in low- and 
middle-income countries. It is estimated that there are more 
than 10 million persons with epilepsy in India. Its prevalence 
is about 1% in our population. The prevalence is higher in 
the rural (1.9%) compared to urban population (0.6%). In 
the Bangalore Urban Rural Neuroepidemiological Survey 
(BURNS), estimated that a prevalence rate of 8.8/1000 
population was observed, with the rate in rural communities 
(11.9) being twice that of urban areas (5.7). 

Epilepsy accounts for 0.6% of the global burden of 
disease, a time-based measure that combines years of life 
lost due to premature mortality and time lived in less than 
full health. In terms of health care needs, premature death 
and lost work productivity, epilepsy has significant economic 
implications. 

 
An Indian study conducted in 1998 calculated that the 

cost per patient of epilepsy treatment was as high as 88.2% 
of the country’s per capita Gross National Product (GNP), 
and epilepsy-related costs, which included medical costs, 
travel, and lost work time, exceeded $2.6 billion/year (2013 
USD) [1]. 

Estimates suggest that available medication controls 
the seizures in only 50% of patients or decreases the 
incidence in only 75% of patients. The search for agents 
with anticonvulsant activity with more selectivity and lower 
toxicity continues to be an area of investigation in future.

Definitions

Epilepsy 
These are a group of CNS disorders characterized by 

paroxysmal cerebral dysrhythmia, manifesting as brief 
episodes(seizures) of loss or disturbance of consciousness, 
with or without characteristic body movements(convulsions), 
sensory or psychiatric phenomena [4,5]. 

Seizures 
A seizure is a sudden surge of electrical activity in the 

brain. 

Convulsion 
A convulsion is a condition in which body muscles 

contract and relax rapidly and repeatedly, results in an 
uncontrolled shaking of the body [6]. 

 
Theoretical Basis 

Despite the successful development of various new 
antiepileptic drugs (AEDs) in recent decades, the search for 
new therapies with better efficacy and tolerability remains 

an important goal. The discovery and development of a new 
AED relies heavily on the preclinical use of animal models to 
establish efficacy and safety prior to first trials in humans. This 
approach has been very successful and crucially contributed 
to the development of numerous clinically effective AEDs. In 
the discovery and development of new AEDs, animal models 
of seizures or epilepsy serve a variety of purposes. First, they 
are used for identifying novel AEDs. Second, animal models 
are used to evaluate the possible specific efficacies of the 
compound against different types of seizures or epilepsy if 
the antiepileptic activity of a novel compound was detected. 
Third, specific models of AED-resistant seizures are used to 
investigate whether the novel drug has advantages towards 
clinically established AEDs for therapy of difficult-to-treat 
types of seizures or epilepsies. Fourth, animal models are used 
to characterize the preclinical efficacy of novel compounds 
during chronic administration. Such chronic studies can 
serve different objectives, for instance evaluation of whether 
drug efficacy changes during prolonged treatment, e.g. 
because of development of tolerance. Fifth, in view of the 
possibility that chronic brain dysfunctions, such as epilepsy, 
might lead to altered sensitivity to drug adverse effects, 
models with epileptic animals are useful to study whether 
epileptogenesis alters the adverse effect potential of a given 
drug. Sixth, animal models can be used to estimate effective 
plasma concentrations of new AEDs for first clinical trials. 
And finally, seventh, animal models are crucial in discovering 
therapies that may prevent or modify the development of 
epilepsy after brain insults.

Not all animal models of seizures and/or epilepsy can be 
used for all of the above-described purposes. Furthermore, 
the intention of the experiment is essential for selection of a 
suitable animal model. For instance, simple seizure models 
such as the maximal electroshock seizure (MES) test, allowing 
to test high numbers of compounds for anticonvulsant 
activity in relatively short time, will be preferred above more 
complex models in screening approaches of anticonvulsant 
drug development. 

For AED discovery, which necessitates screening of large 
numbers of compounds, animal models should be easy-to-
perform, time- and cost-efficient, and predictive of clinical 
activity. This explains that two simple seizure models in mice 
and rats, the MES and pentylenetetrazole (PTZ) tests, which 
have been developed >60 years ago, are still the most widely 
used animal seizure models employed in the search for new 
AEDs [7,8]. 

 
Experimental models 

These models for testing antiepileptic drugs have also 
shed light on the etiopathogenesis of epilepsy. Maximal 
electroshock seizures: Brief high intensity shock is applied to 
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the head of a rodent produces tonic flexion- tonic extension-
clonic convulsions. The tonic phase (especially extensor) 
is selectively abolished by drugs effective in generalized 
tonic clonic seizure. Activity in this model represents action 
on spread of seizure discharge. Pentylenetetrazol clonic 
seizures (PTZ): Injection of PTZ in rats or mice produces 
clonic convulsions which are prevented by drugs effective in 
absence seizures. Activity in this model represents action on 
seizure focus itself. 

Chronic focal seizures: Produced by application of 
alumina cream on the motor cortex of monkey. Kindled 
seizures: Brief bursts of weak electrical impulses are 
applied to the brain (especially amygdala) intermittently 
over days. After- discharges increase progressively and 
tonic-clonic seizures are produced after 10-15 shocks; with 
time spontaneous seizures have a self-perpetuating and 
reinforcing effect: more neuronal circuits are facilitated 
and recruited in the seizure process. Kindling is probably 
involved in the genesis of clinical epilepsy [5]. 

 
Purpose of The Study 

The current therapy of epilepsy with modern 
antiepileptic drugs (AEDs) is associated with side effects, 
dose-related and chronic toxicity, as well as teratogenic 
effects, and approximately 30% of the patients continue 
to have seizures with current antiepileptic drugs therapy. 
The discovery of novel antiepileptic drugs relies upon 
the preclinical employment of animal models to establish 
efficacy and safety prior to the introduction of the AEDs in 
human volunteers. Natural products from folk remedies have 
contributed significantly in the discovery of modern drugs 
and can be an alternative source for the discovery of AEDs 
with novel structures and better safety and efficacy profiles. 
For the detection of antiepileptic activity, several plants are 
used for the treatment of epilepsy in different systems of 
traditional medicine and these plants have shown activity 
when tested in modern bioassays and many such plants are 
yet to be scientifically investigated. Medicinal plants used 
for the therapy of epilepsy in traditional medicine have been 
shown to possess promising anticonvulsant activities in 
animal models of anticonvulsant screening.

Anxiety

Neuropsychopharmacology may be defined as the branch 
of interdisciplinary neuroscience devoted to the study of 
drugs that have an effect on the nervous tissue and alter the 
behavior. Neuropharmacology deals with the study of effects 
of the drug on nerve cells, their synapses and circuit whereas 
the study of effects of drugs on behaviors, including emotional 
and cognitive mental activities, is Psychopharmacology. It 
associates the frontiers of fundamental neuroscience to the 

management of psychiatric and neurological diseases. This 
branch of science seeks to comprehend how drugs selectively 
affect the CNS to induce sleep, relieve pain, reduce fever, 
suppress muddled movement, prevent seizures or enhance 
attention. Neuropsychopharmacology seeks to understand 
how drugs can treat mania, anxiety, schizophrenia or 
depression without disturbing the consciousness. This field 
seeks to uncover the biological basis for intricate mental 
states. The goal of this field is not only to understand the 
nature of the alterations in biology which direct to distorted 
emotions and thought processes, but also to develop 
therapeutically priceless specific molecules which regulate 
the specific biologic underpinnings- namely, the as yet 
vague sequences of multineuronal interactions by which the 
behaviors emerge.

Anxiety may be defined as an unpleasant state of mental 
uneasiness, apprehension, nervousness and obsession or 
concern about something uncertain. The major symptoms 
include; arousal, tenseness, increased autonomic activity 
like respiration, blood pressure and heart rate. Tightness 
in chest, palpitations, perspirations etc. it is a common 
symptom in a variety of distinct mental illnesses and is a 
predominant symptom in panic disorders, phobias and 
obsessive-compulsive disorder.

The major types of anxiety include:
Panic Disorder: Psychiatric condition associated with 
multiple disabling panic attacks. In between the panic attacks, 
an excessive time is spent by the individual in thinking about 
future panic attacks.
Generalized Anxiety Disorder: It is characterized by 
persistent and excessive worries. The patient worries about 
various life events such as job performances, marital status, 
money, social status etc.
Posttraumatic Stress Disorder: Caused due to the exposure 
of individual to life-threatening or terrifying life events. The 
individual re-experiences the traumatic event as flashbacks 
or as intrusive recollections.
Obsessive–Compulsive Disorders: The root cause of 
the disorder is intrusive, repetitive compulsions and / or 
thoughts. Marked distress is the hallmark of this disorder. 
There occur irrational thoughts and acts which impair 
normal functioning. 
Drug therapy

Antianxiety Drugs:

Benzodiazepines: Diazepam, lorazepam, alprazolam
Azapironees: Buspirone 
Sedative antihistaminic: Hydroxyzine
Beta blocker: Propranolol
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Review of Literature

Epilepsy 

Epilepsy is a chronic CNS disorder characterized by 
brief episodes of seizures and excessive EEG discharge. It 
is usually associated with loss of consciousness, violent 
spasmodic contractions of skeletal muscles (convulsions) 
and autonomic hyperactivity [9].

Epilepsy is one of the most common neurological 
disorders. Worldwide, the prevalence is estimated to be 
0.5- 1%, and there is a lifetime incidence of 1- 3%. It has 
important medical, social and psychological consequences. 
Epilepsy is a heterogeneous symptom complex, a chronic 
disorder characterized by recurrent seizures. Seizures 
resulting from abnormal discharge of cerebral neurons and 
are finite episodes of brain dysfunction. It is estimated that 
in India (with population more than 1 billion), there will be 
6- 10 million people with epilepsy, accounting for nearly 1/5 
of global burden. The current treatment of epilepsy with 
modern antiepileptic agents is associated with side effects, 
dose-related and chronic toxicity, as well as teratogenic 
effects, and approximately 30% of the patients continue 
to have seizures with current antiepileptic drugs therapy. 
Therefore, there is a great need for the development of 
cheap, effective and safe anticonvulsant agents from plants 
and other sources [10].

 
Nature of Epilepsy 

The term epilepsy is used to define a group of neurological 
disorders all of which exhibit periodic seizures. Not all 
seizures involve convulsions. Seizures are associated with 
episodic high-frequency discharge of impulses by a group 
of neurons (sometimes referred to as focus) in the brain. 
What starts as a local abnormal discharge may then spread 
to other areas of the brain. The site of the primary discharge 
and the extent of its spread determine the symptoms that are 
produced, which range from a brief lapse of attention to a 
full convulsive fit lasting for several minutes, as well as odd 
sensations or behaviours. 

The particular symptoms produced depend on the function 
of the region of the brain that is affected. Thus, involvement 
of the motor cortex causes convulsions, involvement of the 
hypothalamus causes peripheral autonomic discharge, and 
involvement of the reticular formation in the upper brain 
stem lead to loss of consciousness [11].

 
Types

 Generalised Seizures
1.	 Generalized Tonic-Clonic Seizures (Major Epilepsy, 

Grand Mal): commonest, lasts 1-2 min. Prolonged 

sleep and depression of all CNS functions after the usual 
sequence that is aura-cry-unconsciousness-tonic spasm 
of all body muscles-clonic jerking followed by 

2.	 Absence Seizures (Minor Epilepsy, Petit Mal): 
prevalent in children, lasts about ½ min. Sudden loss of 
consciousness, no muscular component or little bilateral 
jerking, patient apparently freezes and stares in one 
direction. 

3.	 Atonic Seizures (Akinetic Epilepsy): unconsciousness 
with relaxation of all muscles due to excessive inhibitory 
discharges. Patient may fall. 

4.	 Myoclonic Seizures: shock-like momentary contractions 
of muscles of a limb or the whole body. 

5.	 Infantile Spasms (Hypsarrhythmia): These type 
of epilepsy seen in infants and probably not a form of 
epilepsy. Intermittent muscle spasm and progressive 
mental deterioration. 

Partial seizures 
1.	 Simple Partial Seizures (Cortical Focal Epilepsy): 

Lasts ½-1 min. Often secondary. Depending on the area 
of cortex involved, convulsions are confined to a group of 
muscles or localized sensory disturbance, without loss 
of consciousness. 

2.	 Complex Partial Seizures (Temporal Lobe Epilepsy): 
attacks of bizarre and confused behaviour and 
purposeless movements, emotional changes lasting 
1-2 min along with impairment of consciousness. An 
aura often precedes. The seizure focus is located in the 
temporal lobe. 

3.	 Simple Partial or Complex Partial Seizures 
Secondarily Generalized: The partial seizure occurs 
first and evolves into generalized tonic clonic seizures 
with loss of consciousness [5].

Causes 

All forms of epilepsy have their origin in the brain. 
The different types of epilepsies are not based on a single 
underlying mechanism but are multifactorial in origin. 
Epilepsy results when many neurons in union, under a high 
excited stage, deliver massive discharges abolishing a finely 
organized pattern of the integrative activity of the brain. 

John Jackson proposed that these seizures are caused 
by occasional, sudden, excessive, rapid and local discharges 
of grey matter and once initiate by the abnormal focus, the 
seizures attack the neighboring normal brain resulting 
into generalized convulsions. This abnormal focus may 
originate as a result of local biochemical changes, ischemia 
or the loss of vulnerable cell inhibitory systems. However, 
certain physiological changes may trigger the focus and thus 

https://medwinpublishers.com/APCT/


Advances in Pharmacology and Clinical Trials
5

Mujeebuddin CS and Suresh. Investigate the Anticonvulsant and Neuroprotective Effects of 
Commercially Available Humid Acid by Utilizing both In Silico and In Vitro Approaches. Adv in 
Phar & Clin Tria 2026, 11(1): 000259.

Copyright©  Mujeebuddin CS and Suresh.

facilitate the spread of abnormal electrical activity to normal 
tissue. Such factors include.

Genetic Factors 

Several types of epilepsy have now been linked to 
defective genes for ion channels, the “gates” that control the 
flow of ions in and out of cells and regulate neuron signaling. 
Another gene, which is missing in people with progressive 
myoclonus epilepsy, codes for a protein called cystatin B. This 
protein regulates enzymes that break down other proteins. 
Another gene, which is altered in a severe form of epilepsy 
called LaFora’s disease, has been linked to a gene that helps 
to break down carbohydrates. 

Other Disorders 

In some cases, epilepsy may develop as a result of brain 
damage from other diseases. For example, brain tumors, 
alcoholism, and Alzheimer’s disease frequently lead to 
epilepsy because they alter the normal workings of the brain. 
Strokes, heart attacks, and other conditions that diminishes 
the supply of oxygen towards brain, also can cause epilepsy 
in some cases. About 32 percent of all cases of newly 
developed epilepsy in elderly people appears to be due to 
cerebrovascular disease, which reduces the supply of oxygen 
to brain cells. Meningitis, AIDS, viral encephalitis, and other 
infectious diseases and also ahydrocephalus -- a condition in 
which excess fluid builds up in the brain can lead to epilepsy. 
Epilepsy also can result from intolerance to wheat gluten 
(also known as celiac disease), or from a parasitic infection 
of the brain known as neurocysticercosis. 

Epilepsy is having connection with a variety of metabolic 
diseases such as cerebral palsy, pyruvate dependency, 
tuberous sclerosis, Landau-Kleffner syndrome, and autism. 
Epilepsy is just one of a set of symptoms commonly found in 
people with these disorders. 

Head Injury, Prenatal Injury and Developmental 
Problems 

The developing brain is susceptible to many kinds 
of injury. Some conditions like Maternal infections, poor 
nutrition, and oxygen deficiencies that may affect the brain 
of a developing baby. These conditions may lead to cerebral 
palsy, which often is associated with epilepsy, or they may 
cause epilepsy that is unrelated to any other disorders. 

Poisoning 

Exposure to lead, carbon monoxide, and many 
other poisons may cause seizures. They also can result 
from exposure to street drugs and from overdoses of 

antidepressants and other medications. 

Seizures are often triggered by factors such as lack of 
sleep, alcohol consumption, stress, or hormonal changes 
associated with the menstrual cycle. For some people, a 
seizure can also be triggered by light flashing at a certain 
speed or the flicker of a computer monitor and this type 
of epilepsy is known as photosensitive epilepsy. Smoking 
cigarettes also can trigger seizures. The nicotine in cigarettes 
acts on receptors for the excitatory neurotransmitter 
acetylcholine in the brain, which increases neuronal firing. 
Seizures are not triggered by sexual activity except in very 
rare instances [2]. 

Aetiologically, the epilepsies are classified into four 
groups: idiopathic, symptomatic, cryptogenic and progressive. 
The idiopathic epilepsies are thought to be genetically 
determined and are usually associated with particular clinical 
characteristic and specific electroencephalography (EEG) 
findings. Structural abnormality of the brain can result in 
symptomatic epilepsies and are acquired condition. Epilepsy 
is classified as cryptogenic when no clear abnormality or 
putative risk factor is identified for what is presumed to be 
a symptomatic or acquired epileptic condition. The term 
progressive epilepsy is used when epilepsy is associated 
with an evolving neurological condition [12,13].

 
Symptoms 

Repeated seizure is the major cause of epilepsy. The 
individual should see a doctor If one or more of the following 
symptoms are present, especially if the symptoms recur: 
•	 A convulsion with no temperature (no fever) 
•	 Confused memory or short spells of blackout 
•	 Intermittent fainting spells, during which loss of bowel 

or bladder control, followed by extreme
•	  tiredness 
•	 For a short period, the person is unresponsive to 

instructions or questions 
•	 The person becomes stiff, suddenly, for no apparent 

reason 
•	 The person suddenly falls 
•	 The person shows sudden bouts of blinking without 

apparent stimuli 
•	 Sudden bouts of chewing, without any apparent reason 
•	 For a short time, the person seems dazed and unable to 

communicate 
•	 Repetitive movements that seem inappropriate 
•	 The person becomes fearful for no apparent reason; they 

may even panic or become angry 
•	 Peculiar changes in senses, such as smell, touch, and 

sound 
•	 The arms, legs, or body jerk, in babies these will appear 

as a cluster of rapid jerking movements
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 The following conditions need to be eliminated as 
they may appear as similar symptoms and are sometimes 
misdiagnosed as epilepsy: 
•	 High fever with epilepsy-like symptoms 
•	 Fainting 
•	 Narcolepsy - recurring episodes of sleep during the day 
•	 Cataplexy - periods of extreme weakness 
•	 sleep disorders 
•	 nightmares [13] 

 
Syndromes 

Cases of epilepsy may be arranged into epilepsy 
syndromes on the basis of specific features that are present. 
These features include, the seizure types, EEG findings, the 
age that seizure begins. Identifying an epilepsy syndrome is 
useful as it helps determine the underlying causes as well as 
what anti-seizure medication should be tried. 

Since the onset of seizures is commonly early, the ability 
to categorize a case of epilepsy into a specific syndrome 
occurs more often with children. Less serious examples 
are benign rolandic epilepsy (2.8 per 100,000), childhood 
absence epilepsy (0.8 per 100,000) and juvenile myoclonic 
epilepsy (0.7 per 100,000). Severe syndromes with 
diffuse brain dysfunction caused, at least partly, by some 
aspect of epilepsy, are also commonly known as epileptic 
encephalopathies. These are associated with frequent 
seizures that are resistant to treatment and severe cognitive 
dysfunction, for instance Lennox–Gastaut syndrome and 
West syndrome. Genetics is believed to play an important 
role in epilepsies by a number of mechanisms. Simple and 
complex modes of inheritance have been identified for some 
of them. However, extensive screening have failed to identify 
many single gene variants of large effect. 

Syndromes in which causes are not clearly identified 
are difficult to match with categories of the current 
classification of epilepsy. Categorization for these cases was 
made somewhat arbitrarily. In case of 2011 classification 
(idiopathic category) includes syndromes in which the 
general clinical features and/or age specificity strongly point 
towards a genetic cause. Some childhood epilepsy syndromes 
are included in the unknown cause category in which the 
cause is presumed genetic, for instance benign rolandic 
epilepsy. Others are included in symptomatic in some cases 
despite a presumed genetic cause, for example Lennox-
Gastaut syndrome. Clinical syndromes in which epilepsy 
is not the main feature (e.g. Angelman syndrome) were 
categorized symptomatic but it was argued to include these 
within the category idiopathic. Classification of epilepsies 
and particularly of epilepsy syndromes will change with 
advances in research [14].

  
Pathophysiology 

Action potential is the basic mechanism of neuronal 
excitability. Action potential is a hyperexcitable state can 
result from increased excitatory synaptic neurotransmission, 
decreased inhibitory neurotransmission, an alteration in 
voltage-gated ion channels, or an alteration of intra- or 
extra-cellular ion concentrations in favor of membrane 
depolarization. Membrane potential can varies with activation 
of ligand- gated channels, whose conductance is affected by 
binding to neurotransmitters; or with activation of voltage-
gated channels, whose conductance is affected by changes in 
transmembrane potential; or with changes in intracellular 
ion compartmentalization. The major neurotransmitters in 
the brain are glutamate, gamma-amino-butyric acid (GABA), 
acetylcholine (ACh), norepinephrine, dopamine, serotonin, 
and histamine. The major excitatory neurotransmitter is the 
amino acid glutamate. All ionotropic glutamate receptors 
are permeable to Na+ and K+, and it is the influx of Na+ 
and outflow of K+ through these channels that contribute 
to membrane depolarization and generation of the action 
potential. The NMDA receptor also has a Calcium channel and 
in resting state, calcium channel is blocked by Magnesium 
ions, but under conditions of local membrane depolarization, 
Mg++ is displaced and the channel becomes permeable to 
Ca++. Influx of Ca++ tends to further depolarize the cell, and 
is thought also to contribute to Ca++ mediated neuronal 
injury under conditions of excessive neuronal activation 
(such as status epilepticus and ischemia), potentially leading 
to cell death, a process termed excitotoxicity. 

The major inhibitory neurotransmitter, GABA, interacts 
with 2 major subtypes of receptor: 

GABAA and GABAB receptors. GABAA receptors are 
found postsynaptically, while GABAB receptors are found 
presynaptically, and can thereby modulate synaptic release. 
GABAA receptors are permeable to Cl- ions in adult brain 
and action potential is inhibited by upon activation Cl- 
influx hyperpolarizes the membrane. Therefore, substances 
which are GABAA receptor agonists, such as barbiturates 
and benzodiazepines, are well known to suppress seizure 
activity. Rather than Cl- channels, GABAB receptors are 
associated with second messenger systems, and due to 
their presynaptic location, attenuation of transmitter 
release occurs. The second messenger systems often result 
in opening of K+ channels, leading to a hyperpolarizing 
current. 

 
Certain GABAB agonists, such as baclofen, have been 

reported to exacerbate hyperexcitability and seizures [15]. 
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Figure 1: Pathophysiology of epilepsy.

Diagnosis 

Abnormal electrical activity during and following a 
seizure can be detected by electroencephalography (EEG) 
recording from electrodes distributed over the surface of the 
scalp. Various types of seizure can be recognized on the basis 
of the nature and distribution of the abnormal discharge. 
Modern brain imaging techniques, such as magnetic 
resonance imaging and positron emission tomography, are 
now routinely used in the diagnosis of epilepsy to identify 
structural abnormalities (eg. Lesions, tumors) that cause 
certain epilepsies [11]. 

 
Treatment 

Once epilepsy is diagnosed, it is important to begin 
treatment as soon as possible. Once seizures and their 
consequences become established, research suggests that 
current available medication and other treatments may be 
less successful in treating epilepsy. 

Medications 

By far the most common approach to treating epilepsy is 
to prescribe antiepileptic drugs. Doctors diagnosing a patient 
with newly developed epilepsy often prescribe antiepileptic 
agents like carbamazepine, valproate, lamotrigine, 
oxcarbazepine, or phenytoin first, unless the developed 
epilepsy is a type that is known to require a different kind 
of treatment. For absence seizures, ethosuximide is often 
the primary treatment. Other commonly prescribed drugs 
include clonazepam, phenobarbital, and primidone. Some 
relatively new epilepsy drugs include tiagabine, gabapentin, 
topiramate, levetiracetam, and felbamate [2].

Classification 

1.	 Barbiturate: Phenobarbitone 
2.	 Deoxybarbiturate: Primidone 
3.	 Hydantoin: Phenytoin, Fosphenytoin 
4.	 Iminostilbene: Carbamazepine, Oxcarbazepine 
5.	 Succinimide: Ethosuximide 
6.	 Aliphatic carboxylic acid: Valproic acid, Divalproex 
7.	 Benzodiazepines: Clonazepam, Diazepam, Lorazepam, 

Clobazam 
8.	 Phenyltriazine: Lamotrigine 
9.	 Cyclic GABA analogues: Gabapentin, Pregabalin 
10.	 Newer drugs: Topiramate, Zonisamide, Tiagabine [5].

 
Mechanism of Action 

•	 The currently available anticonvulsant agents are 
thought to act by three main mechanisms: 

1.	 Reducing electrical excitability of cell membranes, 
mainly through use dependent block of sodium 
channels 

2.	 Enhancing GABA-mediated synaptic inhibition; this 
may be achieved by an enhanced postsynaptic action of 
GABA, by inhibiting GABA transaminase or by inhibiting 
GABA uptake into neurons and glial cells 

3.	 Inhibiting T-type calcium channels (important in 
controlling absence seizures). 

•	 Newer drugs act by other mechanisms, largely yet to be 
elucidated. 

•	 Drugs that block ionotropic glutamate receptors are 
effective in animal models but are unsuitable 

•	 for clinical use [11]. 
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Figure 2: Mechanism of action of Antiepileptic drugs.

Surgery to Treat Underlying Conditions 

When seizures are caused by a brain tumor, 
hydrocephalus, or other conditions that can be treated 
with surgery, doctors may operate to treat these underlying 
conditions. In many cases, once the underlying condition is 
successfully treated, a person’s seizures will disappear as 
well.

 
Surgery to Remove a Seizure Focus

Removal of a seizure focus, or small area of the brain 
where seizures originate is the most common type of surgery 
for epilepsy. This type of surgery, which doctors may refer to 
as a lobectomy or lesionectomy, is appropriate only for focal 
seizures that originate in just one area of the brain. 

Indications of Surgery 

1.	 Medically intractable seizures 
2.	 Seizures significantly affect the quality of life 
3.	 Localized seizure focus 
4.	 Presence of signs predictable of seizure persistence 

 
Contraindications of Surgery 

1.	 Benign, self-limited epilepsy syndrome 
2.	 Neurodegenerative and metabolic disorders 
3.	 Non-compliance with drugs 
4.	 Severe family disfunctions 

5.	 Associated psychosis 

Multiple Subpial Transection 

When seizures originate in part of the brain that cannot 
be removed, surgeons may perform a procedure called a 
multiple subpial transection 

 
Corpus Callosotomy 

In children with severe seizures that start in one half of 
the brain and spread to the other side, Corpus callosotomy, 
or severing the network of neural connections between the 
right and left halves, or hemispheres, of the brain, is done. 

 
Hemispherectomy and Hemispherotomy 

These procedures remove half of the brain’s cortex, or 
outer layer. These are used mainly in children who are suffering 
from seizures that do not show response to medication 
because of damage that involves only half the brain, as occurs 
with conditions such as Rasmussen’s encephalitis, Sturge-
Weber syndrome, and hemimegencephaly.

 
Devices 

The vagus nerve stimulator was approved by the U.S. 
Food and Drug Administration (FDA) in 1997 for use in people 
with seizures that are not well-controlled by medication. 
The vagus nerve stimulator is a battery-powered device that 
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is surgically implanted under the skin of the chest, much 
like a pacemaker, and is attached to the vagus nerve in the 
lower neck. This device delivers short bursts of electrical 
energy to the brain via the vagus nerve. Researchers are 
studying whether transcranial magnetic stimulation (TMS), a 
procedure which uses a strong magnet held outside the head 
to influence brain activity, may reduce seizures. They also 
hope to develop implantable devices that can deliver drugs 
to specific parts of the brain [2]. 

Diet 

Ketogenic diet is one of the oldest methods of treating 
childhood epilepsy. In children with refractory seizures 

who have failed drug therapy and are not candidate for 
epilepsy surgery, this therapy is as or more effective than the 
addition of new anti-epileptic drug. For example, it remains 
a reasonable alternative for children with Lennox-Gastaut 
syndrome refractory to standard drug therapy. 

The ketogenic diet consists of a higher proportion of 
fats and small amounts of carbohydrates and protein. The 
basis of the therapeutic effectiveness of the ketogenic diet 
is because of the ketosis that develops when the brain is 
relatively deprived of glucose as an energy source and must 
shift to utilization of ketone bodies as the primary fuel [16].

Figure 3: Therapeutic strategies for managing newly diagnosed epilepsy.

Antiepilepsy Activity

Avanthi E et al., (2016) 

Evaluated the antiepileptic activity of clove oil by MES 
model in mice. A total of thirty mice were taken, they were 
given an electroconvulsive shock. Thirty mice were divided 
into five groups of six animals each, the control group 
received distilled water 5ml/kg i.p, standard received Inj. 
Sodium valproate 200 mg/kg i.p. another group received 
Sesame oil – 10ml/kg i.p(control), test groups received Clove 
oil- 0.075 ml/kg i.p., Clove oil-0.1ml/kg i.p respectively. All 

the injections were given 30 minutes before the test. The 
results showed Clove oil produced significant antiepileptic 
effect at all the doses [17]. 

 
K Sandeep Kumar et al., (2015) 

Evaluated the antiepileptic activity of ethanolic extract of 
Biophytum sensitivum in animal models. The anticonvulsant 
activity was assessed using MES and PTZ using albino mice. 
The extract reduced the duration of tonic hind limb extension 
and delayed the onset of tonic clonic convulsion. The result 
showed that the ethanolic extract of the plant beneficial in 
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both tonic clonic and absence seizures [10]. 
 
Nirmala D (2015) 

Performed a study which involves in detecting 
anticonvulsant activity from Annacyclus pyrethrum roots 
by using maximal electroshock seizure (MES) in a dose-
dependent way. MES-induced tonic seizures can be prevented 
either by drugs that inhibit voltage dependent Na+ channels, 
such as phenytoin, valproate and lamotrigine or by drugs 
that block glutamatergic excitation mediated by the NMDA 
receptor such as felbamate. The study showed that ethanolic 
extract from roots of A. pyrethrum can inhibit voltage 
dependent Na+ channels as phenytoin in MES induced tonic 
seizures [18]. 

 
Gummalla Pitchaiahet al., (2015) 

Evaluated the anticonvulsant activity of methanolic 
extract of Allium cepa (Onion) bulbs in Swiss albino mice. 
The anticonvulsant effect was assessed using maximal 
electroshock (MES) and Isoniazid (INH) induced seizure 
models. Methanolic extract (200 and 400 mg/kg) showed 
significant reduction in the duration of hind limb extensor 
phase in electroshock convulsions; protected the mice 
against the Isoniazid induced convulsions. The results 
showed significant improvement in brain GABA levels after 
Allium cepa treatment [19]. 

 
Santilna K S et al., (2014) 

Studied the anticonvulsant activity study of Artemisia 
nilagirica. The leaves part of the plant was dried, powdered 
and subjected to maceration using diethyl ether, chloroform 
and ethanol. The results showed that the alkaloids, 
flavonoids and terpenoids were identified to be present in 
all three solvents extracts. The result obtained suggests that 
the ethanolic and chloroform extracts of Artemisia nilagirica 
may be beneficial in the treatment of epilepsy [20]. 

 
Ravindra C Sutar et al., (2014) 

Evaluated the anticonvulsant activity of leaf extract of 
Holoptelea integrifolia. The petroleum ether and methanolic 
extract of the leaves was evaluated using Pentylenetetrazole 
(PTZ) induced convulsions in mice and maximal electroshock 
(MES) induced Convulsions and lithiumpilocarpine induced 
status epilepticus in rats. The petroleum ether extract 
and methanolic extract delayed onset of PTZ- induced 
convulsions and also prolonged the onset of tonic convulsions 
in mice. Both the extracts failed to protect the rats from MES 
induced convulsions. The extracts also protected rats against 
seizures induced by lithium-pilocarpine. The results indicate 
that petroleum ether and methanol extracts contained 

such phytochemial compounds which are active in case of 
Pentylenetetrazole (PTZ) and lithium pilocarpine induced 
status epilepticus, which support the ethnomedicinal 
application of the plant as an anticonvulsant agent [21]. 

 
Dilnawaz Pathan et al., (2014) 

Evaluated the anticonvulsant effect of ethanolic 
extract of roots of Picrorhiza kurroa on electrically and 
chemically induced seizures. The extract was studied for 
its anticonvulsant effect on maximal electroshock-induced 
seizures and pentylenetetrazole, picrotoxin induced seizures 
in mice. It has been observed in the present study that extract 
(100 mg/kg) showed significant increase in latency to clonic 
convulsions and reduced mortality. The results shows that 
Picrorhizakurroa possess anticonvulsant activity against 
Pentylenetetrazole, Maximal electroshock and Picrotoxin 
induced convulsions in mice [22]. 

 
Ganapathi G. Varmaet al., (2014) 

Performed the evaluation of antiepileptic activity of 
methanolic leaves extract of Tragia involucrata in mice. In 
vivo screening models like maximal electroshock-induced 
convulsion (MES), pentylenetetrazole (PTZ) and picrotoxin 
(PTX) induced models are used to evaluate the antiepileptic 
effects of the extracts. In the MES induced convulsion, 
methanolic extract (800 mg/kg), showed high significant 
inhibition on tonic hind limb extension and decrease in 
duration of stupor period. In PTZ and PTX induced model 
extract (400 mg/kg and 800 mg/kg) showed delay on the 
onset of convulsions, decreased duration of convulsion and 
reduced mortality significantly. The results showed that 
Tragiainvolucrata possesses dose dependent antiepileptic 
activity [23]. 

 
Mehrdad Modaresi et al., (2014) 

Studied the antiepileptic activity of hydroalcoholic 
extract of Ocimum basilicum in mice. The experimental 
groups comprised control, sham, and four treatment groups 
receiving the extract at 100, 250, 300, and 350 mg/kg doses 
65 minutes before PTZ injection. The obtained results of 
using different doses of the extract indicated that the mice 
receiving the extract at 100 and 250 mg/kg doses exhibited 
the highest and lowest frequency of myoclonic twitches, 
respectively [24]. 

 
Chinchawade A B et al., (2013) 

Observed the anticonvulsant activity of chloroform extract 
of bark & root of Erythrina variegate. The pentyleneterazole 
(PTZ) and the maximal electroshock seizure (MES) models 
were used for assessing the anticonvulsant effects of the 
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chloroform extract in mice and rats. The extract produced 
significant protection against PTZ-induced and MES 
induced convulsions in rat. The results obtained from this 
study indicate that the chloroform root and bark extract of 
Erythrinavariegata may be beneficial in both absence and 
tonic clonic seizures [25]. 

 
Abubakar K et al., (2013) 

Evaluated the anticonvulsant effect of methanolic extract 
of Evolvulus alsinoides in mice using pentyleneterazole 
(PTZ) and the maximal electroshock seizure (MES) model. 
The extract significantly increased the latency of PTZ 
induced seizure. In the MES test a dose dependent decrease 
in the duration of seizure was also observed. These findings 
suggest that the methanol extract of the plant contains 
bioactive principles that may be beneficial in the treatment 
of epilepsy [26]. 

Ashish P Anovadiya et al., (2013) 

Performed the antiepileptic and memory retention 
activity of Curcumin perse and in combination with 
antiepileptic drugs. In this study, antiepileptic activity of 
curcumin and its combination with phenytoin and sodium 
valproate were studied in chronic model (14 days) of 
Maximal Electroshock Seizure (MES) and Pentylenetetrazole 
(PTZ) induced seizure respectively. Curcumin (100 mg/kg) 
reduced clonic phase and significantly inhibited PTZ induced 
seizure. Addition of curcumin to sub therapeutic dose of 
sodium valproate showed synergistic effect..Curcumin found 
to be effective in absence seizure alone and as add on with 
sodium valproate [27]. 

 
Prabhat Singh et al., (2012)

Studied antiepileptic activity of aqueous extract of fruits 
of Tricosanthes dioica. The antiepileptic efficacy of aqueous 
extract was evaluated by hand limb extension induced by 
MES and PTZ induced seizures in mice models. The aqueous 
extract was showed significant antiepileptic activity in 
both models and it was found to be due to activity against 
generalized tonic- clonic and cortical focal seizures [28]. 

 
Vikas Saroch et al., (2012)

Evaluated the anticonvulsant Activity of Apasmarari rasa. 
Apasmarari rasa was subjected to assess the LD 50 and anti-
convulsant activity on Male Albino rats was by means of MES 
(Maximal Electro convulsing Shock) Method. A supramaximal 
strength was 150mA in rats for 0.2 seconds and stimulus was 
applied via ear clip electrodes. The animal dose of Phenytoin 
(7.2mg/kg), Smritisagar rasa (18mg/kg) and Apasmarari 
rasa (5.4mg/ kg) was given orally to different groups. The 
animals were observed for a period of 180 minutes after 

being subjected to electro convulsions. Both standard drugs 
also shown good results when it comes to HLE (hind limb 
extension), butother factors such as time duration of flexion, 
tonus, clonus, recovery time amongst others in test drug 
group (Apasmarari rasa) showed significantly better results 
[29]. 

 
Vipin K Garget al., (2011)

Evaluated the anticonvulsant activity of ethanolic extract 
of Cynodon dactylon. The anticonvulsant activity was studied 
using maximal electroshock (MES) and Pentylenetetrazol 
(PTZ) induced convulsions in mice. The extract suppressed 
hind limb tonic extensions (HLTE) induced by MES and 
also exhibited protector effect in PTZ-induced seizures. The 
results showed that the ethanolic extract of Cynodon dactylon 
has anticonvulsant effect in the both models suggesting their 
possible depressant action in the central nervous system 
[30]. 

 
Shyamjith Manikkoth et al., (2011) 

Performed Phyllanthus amarus on maximal 
electroshock-induced seizures (MES) and pentylenetetrazole 
(PTZ) induced seizures. The aqueous and ethanolic extracts 
of the leaves and stems of P. amarus significantly abolished 
the hind limb extension induced by MES. The same dose also 
significantly protected the animals from PTZ induced tonic 
convulsions [31]. 

 
Harish Babu B et al., (2010) 

Performed anticonvulsant activity of the methanolic 
extract of Martynia annua on Maximal Electroshock(MES) 
and Pentylenetetrazole (PTZ) induced seizures models in 
albino wistar rats. These studies showed, the mean duration 
of extensor phase of test group reduced to significant level 
as compared to control group. In Pentylenetetrazol induced 
seizure test, onset of myoclonic spasm and clonic convulsion 
was delayed in the test group. The study concluded Martynia 
annua possesses an anticonvulsant effect which results from 
the potentiation of the activity of GABA [32]. 

N. S. Vyawahareet al., (2009) 

Evaluated the anticonvulsant activity of roots of Argyreia 
speciosa in mice. The mice were pretreated with different 
doses of Argyreia speciosa extract for 10 days and then, 
they were subjected to either pentylenetetrazole or maximal 
electroshock seizures treatment. The hydroalcoholic 
extract of Argyreia speciosa at the dose of 200 and 400 
mg/kg significantly delayed the latency to the onset of first 
clonus and significantly reduced the duration of hind limb 
extension. This study shows that the hydroalcoholic extract 
possesses anticonvulsant activity against pentylenetetrazole 

https://medwinpublishers.com/APCT/


Advances in Pharmacology and Clinical Trials
12

Mujeebuddin CS and Suresh. Investigate the Anticonvulsant and Neuroprotective Effects of 
Commercially Available Humid Acid by Utilizing both In Silico and In Vitro Approaches. Adv in 
Phar & Clin Tria 2026, 11(1): 000259.

Copyright©  Mujeebuddin CS and Suresh.

and maximal electroshock seizures [33]. 
 
KarunakarHegde et al., (2009)

Studied the anticonvulsant activity of Carissa carandas 
root extract in experimental mice. The ethanolic extract was 
studied for its anticonvulsant effect on maximal electroshock-
induced seizures and pentylenetetrazole-, picrotoxin-, 
bicuculline- and N-methyl-dl-aspartic acid induced seizures 
in mice. The data suggest that the ethanolic root extract 
reduced the duration of seizures produced by maximal 
electroshock as well as delayed the latency of seizures 
produced by pentylenetetrazole and picrotoxin [34]. 

Scope and Plan of Work

According to network pharmacology, medicines affect 
complex biological networks as opposed to single targets 

or pathways. Accordingly, rather than focusing on a single 
target, a drug’s effectiveness is determined by its ability 
to affect a network of targets or pathways. It includes two 
major approaches Network Biology and Polypharmacology. 
Network Pharmacology is an integrative and systems 
approach to understand complex relationship between 
molecules in cells whereas, polypharmacology is the ability 
of the molecule or ligand to interact with multiple proteins. 
Therefore, here various databases were used to identify 
various targets of disease and phytoconstituents and the 
common targets identified between them were used for 
further analysis i.e., In-silico studies. As targeting a single 
protein can increase the chances of failure therefore, 
multiple proteins were targeted by the ligand selected to see 
the actions of ligand on those receptors, acting as a potential 
molecule.

Figure 4: Pictorial Representation of Network Pharmacology.

This pictorial explains the work that has been carried 
out. It explains how using various databases the top proteins 
and ligands were identified and how in-silico studies 
helped in understanding the effect of ligand on top proteins. 
This explains how network pharmacology and molecular 
modelling approach can help treating Alzheimer’s Disease.

Aim

To evaluate the antiepileptic and anti-anxiety activities 
of Phyllanthus reticulatus using network pharmacology 
approach.

Objectives

•	 To identify the phytoconstituents present in Phyllanthus 
reticulatus using literature survey, IMPAAT and Dr Dukes 
databases.

•	 To perform pharmacokinetic screening of the selected 
phytoconstituents using quikprop tool of Schrodinger.

•	 To predict the phyto-targets of Phyllanthus reticulatus 
using Swiss Target Prediction and the BindingDB 
databases.

•	 To predict the therapeutic targets of epilepsy and anxiety 
using Disgenet database.
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•	 To identify the common targets between phyto-targets 
and disease targets using venny tool.

•	 To build a protein-protein interaction network using 
string database

•	 To perform topological analysis using Cytoscape 
software to identify the key proteins in the network.

•	 To perform gene ontology and pathway analysis using 
Funrich software and reactome database.

•	 To perform molecular docking and molecular dynamics 
to assess the binding affinity and binding stability of the 
protein ligand complex.

Plan of Work

Phase I
•	 Literature survey
•	 Identification of phytoconstituents
•	 ADMET Screening
•	 Identification of phyto and disease targets.

Phase II
•	 Identification of common targets
•	 Construction of protein-protein interaction network.
•	 Topological Analysis

Phase III
•	 Gene ontology study
•	 Pathway Analysis

Phase IV
•	 Molecular docking
•	 Molecular dynamics

Materials & Methods

Plant Profile

Phyllanthus reticulatus Poir. is a shrub with smooth or 
lenticellate branches reaching a maximum height of 10 feet 
that belongs to the family Euphorbiaceae. The leaves of the 
plants are traditionally used as diabetic and have also been 
reported to possess diuretic, astringent, and astringent 
properties. The leaf extract of P. reticulatus Poir. has been 
reported to possess antimicrobial properties against Gram-
negative bacteria and the whole plant extract has been 
reported to have antioxidant property.

Kingdom Plantae
Order Malpighiales
Family Euphorbiaceae
Genus Phyllanthus

Species P. Reticulatus

Table 1: Scientific classification of Phyllanthus reticulatus 
Poir.

Figure 5: Phyllanthus reticulatus poir.

Collection of Botanicals and Their 
Phytochemicals

A careful review of the literature utilizing databases 
like PubMed and ScienceDirect led to the identification of a 
list of phytoconstituents present in Phyllanthus reticulatus 
poir. The Indian Medicinal Plants Phytochemistry and 
Therapeutics Database (IMPPAT) (https://cb.imsc.res.in/
imppat/) an Dr. Duke’s Phytochemical and Ethnobotanical 
Databases 

(https://phytochem.nal .usda.gov/phytochem/
search) were used to identify the active phytoconstituents 
found in Phyllanthus reticulatus poir. From the PubChem 
Database, the 2D structures of the active phytoconstituents 
were downloaded in Structure Data File format. (https://
pubchem.ncbi.nlm.nih.gov/) (https://www.sciencedirect.
com/) [35-37].

ADME Screening of Identified Phytochemicals 

QikProp tool in Schrodinger was used to predict the 
ADME properties of the obtained active phytoconstituents. 
Schrodinger’s QikProp  was used to forecast how possible 
drug  compounds would be absorbed, distributed, 
metabolized, and excreted [38].

Screening of Target and Disease Proteins

Swiss Target Prediction and the BindingDB databases 
were used to predict the targets proteins of the active 
phytoconstituents. The foundation of BindingDB is the idea 
that substances with comparable structural characteristics 
may bind to the same target proteins. The targets of 
the chosen phytoconstituents were predicted using the 
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specialised function “Find my compounds target” in 
BindingDB. The target prediction probability was set at 0.85. 
Swiss Target Prediction (http://www.swisstargetprediction.
ch/), which compares a library of 370000 known actives on 
more than 3000 proteins in 2D and 3D space, suggests the 
most likely macromolecular targets for selected compounds. 
The DisGeNet database (https://www.disgenet.org/), was 
used to find the treatment targets related to epilepsy and 
anxiety. DisGeNet is a platform for discovering human genes 
and the diseases they are linked to [36,37]. 

Identification of Common Targets

The targets that are both implicated in the aetiology 
of the selected diseases (epilepsy and anxiety) and serve 
as targets for the phytoconstituents present in Phyllanthus 
reticulatus poir were determined by an analysis using a Venn 
diagram. The Venny tool was used to conduct this analysis. 
(https://bioinfogp.cnb.csic.es/tools/venny/) [36,39]. 

Analysis of Protein-Protein Interaction

The STRING database (https://string-db.org/) was 
used to create the association between the discovered 
common targets. The STRING database’s “multiple proteins” 
option was picked, the common targets were typed into 
the “list of names” box, and “Homo sapiens” was selected 
as the organism. The “SEARCH” button was then used in 
the subsequent step to create a protein-protein interaction 
network of the shared target proteins [40,41].

Topological Analysis

The protein-protein interaction network of 76 common 
targets created in STRING database was exported to the 
Cytoscape software by clicking on the “Export” option > 
“Send network to Cytoscape”.

The network of proteins appeared on the Cytoscape 
terminal.

Go to Apps> CytoNCA > Open. A window will open 
showing the centralities. 

Click on the checkbox of degree centrality (DC), 
betweenness centrality (BC) and closeness centrality (CC) 
and click on Analyze. The topological parameters of the 
protein-protein interaction network were analyzed on the 
basis of these centralities.

Click on the “Node Table” to access the analyzed proteins 
on the basis of the centralities. The proteins are arranged in 
descending order to obtain the list of proteins from highest 
degree centrality to the lowest.

The degree centrality is given reference over other 
centralities [42].

Gene Ontology (Go) Enrichment Analysis

The Gene Ontology (GO) enrichment analysis was done 
with the help of FunRich software, which is a useful tool for 
visualising and analysing functional enrichment in genes and 
proteins. It is an effective tool for examining the functional 
importance of the genomic and proteomic data. The 
enrichment analysis was carried out for biological process 
(BP), molecular function (MF) and cellular process (CP).

Molecular Docking & Molecular Simulation 
Dynamics Studies

Virtual Screening and molecular interaction analysis was 
performed using Schrodinger software to identify the most 
suitable lead molecule acting on the desirable target [43-48]. 

Protein Preparation 
The 3D structure of protein was created using the 

protein preparation wizard in Schrodinger Maestro. Bond 
orders were assigned, the CCD database was used, missing 
hydrogen atoms were added, missing side chains were filled 
in, hydrogen bonds were optimized to prevent steric clashes, 
zero-order bonds to metals and disulfide bonds were formed, 
selenomethionines were converted to methionines, water 
molecules were removed from het groups that were further 
than 5Å, and Epik was used to keep the het state at its default 
pH. Restrained minimization, which converges heavy atoms 
to an RMSD of 0.30Å, was carried out using the OPLS3 force 
field [49,50].

Ligand Preparation
Using Schrodinger maestro’s LigPrep wizard, the 2D 

structures of all the chosen phytoconstituents were converted 
into a simple 3D structure. The potential ionization state was 
produced using Epik at the desired pH of 7.0 2.0 for accurate 
tautomer enumeration and to evaluate the protonation state 
in biological status. A maximum of 32 stereoisomers can 
be produced per ligand by retaining certain chiralities. The 
processes that followed used the lowest penalty state and 
the OPLS3 force field settings [51,52]. 

Receptor Grid Generation
The Schrodinger maestro’s Receptor Grid generation 

function’s default settings were used to create the receptor 
grid files. The ligand required for docking was chosen so that 
a grid would be formed around it. The grid size was set to 
“Dock ligands similar in size to the Workspace ligand” and the 
grid’s centroid served as the box’s center. The partial charge 
cut-off was set at 0.25 and the van der Waals radius scaling 
factor was set to 1.0 when defining the receptor [51,52].
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Molecular docking
The top five selected target proteins (3EMl, 6N4B, 1S8C, 

2BKS, and 6NJS) were docked with the predetermined 
phytoconstituents using Schrodinger Maestro’s extra 
precision (XP) glide. It takes into consideration the penalties 
imposed on non-cis/trans amide bonds. In this case, the 
partial charge cut-off was set to 0.15 and the van der Waals 
scaling factor was set to 0.80. The final score was computed 
using an energy-minimized posture and a glide score. The 
best-bound ligands to the active site were determined based 
on the glide score with the highest negative value [38,43].

Steps to be followed to perform molecular docking are 
listed below:

Open Schrodinger Maestro > Click on File > Go to “Change 
working directory” > Go to the file location where you want 
to save all the data & select the file.

Go to File > Click on “Import Structures” > Select the 
Protein > Import. Delete all the chains of the protein except 
the one required for docking. Also, remove all the water 
molecules and all the ligands. Keep only one ligand or co-
crystal which is required for docking with the protein.

Protein preparation- Go to taskbar > type “Protein 
preparation” and click on Protein preparation wizard > 
type the protein name in the jobname dialog box > Click on 
Preprocess. Processed protein will be obtained.
•	 Go to File > Click on “Import Structures” > Select all the 

ligands > Import.
•	 Ligand preparation – Go to taskbar > type “ligprep” > 

Select all the ligands from the project table > type the file 
name in the jobname dialog box > Run. Prepared ligands 
will be obtained.

•	 Receptor grid generation- Select the prepared protein> 
Go to taskbar > type “Receptor Grid Generation” > Click 
on the ligand/ co-crystal that is required for docking 
with the protein. A grid will be generated around it. Once 
a grid is generated, type the file name in the jobname 
dialog box and Click on Run. 

•	 Molecular Docking – Go to taskbar > type “Ligand 
Docking” > Receptor grid- Select “From file” > Browse 
the File name and select the zip file from the receptor 
grid files generated in the Receptor grid generation 
process. Then, go to “Use ligands from” > Select Project 
table > Go to the project table > Select all the prepared 
ligands from the project table. Click on “use input partial 
charges”. Go to Settings> Select XP (extra precision) and 
select Flexible for ligand sampling> type the file name in 
the jobname dialog box> Run.

•	 Once, docking is completed, Go to Table > Select the 
docking results> Click on Data > Export > Spreadsheet> 
type the filename> Save. 

MMGBSA

The Prime MM-GBSA method was used to calculate 
the binding free energy (ΔGbind) of the selected 
phytoconstituents and the top 5 pharmacological targets. The 
most optimal poses of protein-ligand complexes generated 
using Glide XP docking were selected in order to calculate 
the binding free energy (ΔGbind), as shown in the equation 
below.

ΔGbind =Gcomplex−(Gprotein+Gligand)

where Gcomplex, Gprotein,  and Gligand  are the free 
energies of the complex, protein, and ligand, respectively. 

It has been demonstrated that, despite questionable 
approximations in conformational entropy and the quantity 
of water molecule free energy, the docking data from MM-
GBSA can be employed as an additional scoring function. 
The outcomes also showed that MM-GBSA can distinguish 
between a ligand’s real and decay states in addition to 
rescoring datasets [38,43].

Steps to be followed to perform MMGBSA are listed 
below:
•	 Open Schrodinger Maestro > Click on File > Go to “Change 

working directory” > Go to the file location where you 
want to save all the data & select the file.

•	 Click on File> Import Structures> Select the pv. maegnz 
file from the docking files of the required docked ligand 
and protein for which MMGBSA needs to be performed.

•	 Go to Taskbar > type MM-GBSA and click on it. A Prime 
MM-GBSA dialog box will appear. Select “Take complexes 
from separated protein and ligand structures”. Take 
ligands from: > Click on Selected entries from the project 
table> Select all the prepared ligands from the project 
table.

•	 Take receptor from: > Click on Workspace entry> Select 
the prepared protein from the workspace.

•	 Click on input ligand partial charges and click on “All” in 
protein flexibility. 

•	 Type the file name in the jobname dialog box and click 
on Run.

•	 Once, MMGBSA is completed, Go to Table > Select the 
MMGBSA results> Click on Data > Export > Spreadsheet> 
type the filename> Save. 

Molecular Dynamics

Molecular dynamics simulation (MDS) provides proof 
that docked complexes are stable and that the binding posture 
identified by molecular docking is correct. To evaluate the 
confirmational changes of the protein-ligand complex in the 
solvated system, the MD simulation was carried out using the 
Desmond module of Schrodinger 2020-1, LLC, New York, NY. 
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Under orthorhombic periodic boundary conditions and with 
a 10 A buffer between the protein atoms and box edges, the 
protein-ligand complex was solvated using the TIP3P water 
model. The solvated system was neutralised by adding 0.15M 
NaCl counter ions. The system was then minimised using 
the OPLS3e force field default values. The smooth particle 
mesh Ewald approach was used to predict the long-range 
electrostatic interactions with a tolerance of 1e09. At a cut-off 
radius of 9.0 A, the short-range Van der Waals and Coulomb 
interactions were calculated. The MD simulation was run in 
an isothermal-isobaric ensemble (NPT) for a total of 40 ns 
with a time interval of 2 fs at 300 K and 1 bar of pressure. 
The  Nose-Hoover chain thermostat method and  Martyna-
Tobias-Klein method  were employed together at 100 and 
200 ps, respectively. For bonded, short-range non-bonded, 
and long-range electrostatic forces, 2, 2, and 6 fs of the RESPA 
(Reference System Propagator Algorithm) multiple time-
step techniques were used, respectively. Every 100ps, data 
was collected, and the generated trajectories were examined. 
The behaviour of the trajectories was assessed using the 
Simulation Interaction Diagram tool in the Desmond MD 
package based on root mean square deviation (RMSD) and 
root mean square fluctuation (RMSF). MD results in protein-
ligand interactions, RMSD, and RMSF [38,44,47,48].

Steps to be followed to perform MD are listed below:
•	 Open Schrodinger Maestro > Click on File > Go to “Change 

working directory” > Go to the file location where you 
want to save all the data & select the file.

•	 Click on File> Import Structures> Select the out file from 
the MMGBSA files of the required protein for which MD 
needs to be performed. Also, select the prepared ligand 
for which MD needs to be run.

•	 Firstly, Click on System Builder > Solvation > Predefined- 
TIP3P Solvent Model, Box Shape- Orthorhombic > 
Click on Minimize volume. Then, Go to Ions > Click on 
Recalculate > Type the jobname > Run it with the default 
options.

•	 Then, click on the result obtained from System Builder> 
Energy Minimization> Load. The molecule will be 
loaded. Simulation time set to 100ps> Type the jobname 
>Run it with the default options.

•	 Finally, click on the result obtained from Energy 
Minimization> Click on Molecular Dynamics > Load. The 
molecule will be loaded. Simulation time set to 100 ns > 
Type the file name in the jobname dialog box > Run.

•	 Once, MD is completed, Simulation Interaction Diagram 
is run to generate the results. The results are obtained in 
the form of desmond pdf, raw data and images.

Results

Identification of Botanicals and Retrieval of 
Their Active Constituents

A total of 25 phytoconstituents present in Phyllanthus 
reticulatus were identified through a comprehensive 
literature review and with the help of databases like IMPPAT 
and Dr. Duke’s Phytochemical and Ethnobotanical Database. 
The list of botanicals is presented in table 2 and the SMILES of 
the selected phytoconstituents is given in table 3. The major 
active constituents were identified and downloaded from the 
PubChem database in SDF (Structured Data File) format.

S.no Part Phytoconstituent
1 Stem Hovetrichoside C
2 Root Methyl gallate
3 Leaf Ellagic acid
4 Bark Hovetrichoside A
5 Root Carthamoside A1
6 Leaf Humic acid
7 Root Fulvic acid
8 Leaf Betulinic acid
9 Root Betulin

10 Stem Pinoresinol
11 Root Corilagin
12 Leaf Syringaresinol
13 Stem Epifriedelanol
14 Root Beta-Sitosterol
15 Bark Macranthoside A
16 Bark Lyoniresinol
17 Leaf Methylellagic acid
18 Root Octacosanol
19 Root Tricosanol
20 Leaf Friedelin
21 Leaf Glochidonol
22 Root Pentacosane
23 Bark Sorghumol
24 Root Taraxerol
25 Root Hydroxyfriedelanone

Table 2: List of Phytoconstituents present in Phyllanthus 
reticulatus.
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Part Smiles

Hovetrichoside C C1=CC(=CC=C1CC2(C(=O)C3=C(O2)C=C(C=C3OC4C(C(C(C(O4)CO)O)O)O)O)O)O

Methyl gallate COC(=O)C1=CC(=C(C(=C1)O)O)O

Ellagic acid C1=C2C3=C(C(=C1O)O)OC(=O)C4=CC(=C(C(=C43)OC2=O)O)O

Hovetrichoside A COC1=C(C=CC(=C1)C(CO)C(C2=CC(=C(C=C2)O)OC)OC3C(C(C(C(O3)CO)O)O)O)O

Carthamoside A1 CC=CC#CC#CCCCOC1C(C(C2C(O1)COC(O2)(C)C)O)O

Humic acid C1C2C=CC1C(C2C(=O)O)(C(=O)O)[N+](=O)[O-]

Fulvic acid CC1(CC2=C(CO1)C(=O)C3=C(O2)C=C(C(=C3C(=O)O)O)O)O

Betulinic acid CC(=C)C1CCC2(C1C3CCC4C5(CCC(C(C5CCC4(C3(CC2)C)C)(C)C)O)C)C(=O)O

Betulin CC(=C)C1CCC2(C1C3CCC4C5(CCC(C(C5CCC4(C3(CC2)C)C)(C)C)O)C)CO

Pinoresinol COC1=C(C=CC(=C1)C2C3COC(C3CO2)C4=CC(=C(C=C4)O)OC)O

Corilagin C1C2C(C(C(C(O2)OC(=O)C3=CC(=C(C(=C3)O)O)O)O)OC(=O)C4=CC(=C(C(=C4C5=C(C(=C(C=C5C(=O)
O1)O)O)O)O)O)O)O

Syringaresinol COC1=CC(=CC(=C1O)OC)C2C3COC(C3CO2)C4=CC(=C(C(=C4)OC)O)OC

Epifriedelanol CC1C(CCC2C1(CCC3C2(CCC4(C3(CCC5(C4CC(CC5)(C)C)C)C)C)C)C)O

Beta-Sitosterol CCC(CCC(C)C1CCC2C1(CCC3C2CC=C4C3(CCC(C4)O)C)C)C(C)C

Macranthoside A; CC1C(C(C(C(O1)OC2C(C(COC2OC3CCC4(C(C3(C)CO)CCC5(C4CC=C6C5(CCC7(C6CC(CC7)(C)C)C(=O)
O)C)C)C)O)O)O)OC8C(C(C(C(O8)CO)O)O)O)O

Lyoniresinol COC1=CC(=CC(=C1O)OC)C2C(C(CC3=CC(=C(C(=C23)OC)O)OC)CO)CO

Methylellagic COC1=C(C=C2C3=C1OC(=O)C4=CC(=C(C(=C43)OC2=O)O)O)O

Octacosanol CCCCCCCCCCCCCCCCCCCCCCCCCCCCO

Tricosanol CCCCCCCCCCCCCCCCCCCCCCCO

Friedelin CC1C(=O)CCC2C1(CCC3C2(CCC4(C3(CCC5(C4CC(CC5)(C)C)C)C)C)C)C

Glochidonol CC(=C)C1CCC2(C1C3CCC4C(C3(CC2)C)(CCC5C4(C(CC(=O)C5(C)C)O)C)C)C

Pentacosane CCCCCCCCCCCCCCCCCCCCCCCCC

Sorghumol CC(C)C1CCC2C1(CCC3(C2(CC=C4C3CCC5C4(CCC(C5(C)C)O)C)C)C)C

Taraxerol CC1(CCC2(CC=C3C4(CCC5C(C(CCC5(C4CCC3(C2C1)C)C)O)(C)C)C)C)C

Hydroxyfriedelan CC1C(=O)CCC2C1(CCC3C2(CCC4(C3(CCC5(C4CC(C(C5)O)(C)C)C)C)C)C)C

Table 3: SMILES of the Selected Phytoconstituents present in Phyllanthus reticulatus.

ADME Properties Using Qikprop 

The ADME properties of the selected phytoconstituents 
were studied with the help of QikProp tool of Schrodinger 
software version 13.1. The properties like CNS activity, 
molecular weight, predicted octanol/water partition 

coefficient, predicted brain/ blood partition coefficient 
and Lipinski’s rule of five were obtained. Havetrichoside 
A crossed blood brain barrier within the optimal range of 
(-3.0-1.2) with the values -1.97 and -1.16 respectively. The 
results are presented in the table 4.

https://medwinpublishers.com/APCT/


Advances in Pharmacology and Clinical Trials
18

Mujeebuddin CS and Suresh. Investigate the Anticonvulsant and Neuroprotective Effects of 
Commercially Available Humid Acid by Utilizing both In Silico and In Vitro Approaches. Adv in 
Phar & Clin Tria 2026, 11(1): 000259.

Copyright©  Mujeebuddin CS and Suresh.

Ligands Properties or 
Descriptors

CNS mol MW QPlogPo/w QPlogBB Rule of Five

Humic Acid -2 227.173 0.496 -1.371 0
Fulvic Acid -2 308.244 0.572 -1.872 0

Methyl Gallate -2 184.148 -0.19 -1.444 0
Betulinic acid -1 456.707 6.242 -0.536 1

Betulin 0 442.724 5.981 -0.389 1
Pinoresinol 0 358.39 2.922 -0.691 0

Corilagin -2 634.46 -3.001 -4.893 1
Syringaresinol -1 418.443 3.149 -0.862 0
Epifriedelanol 1 428.74 7.075 0.222 1
β-Sitosterol 0 414.713 7.622 -0.354 1
Ellagic Acid -2 302.197 -1.295 -2.395 0

Macranthoside A -2 913.107 0.463 -4.703 1
Lyoniresinol -2 420.458 2.364 -1.665 0

Methylellagic Acid -2 316.223 -0.536 -1.908 0
Havetrichoside A -2 482.483 -0.455 -1.197 0

Havetrichoside C -2 450.398 -1.162 -2.346 0
Carthomoside A1 -1 350.411 2.854 -0.935 0

Octacosanol 1 410.75 7.075 -1.665 2
Tricosanol 0 340.6 7.622 -1.908 2
Friedelin -2 426.7 -1.295 -1.197 2

Glochidonol -2 440.7 0.463 -2.346 2
Pentacosane -2 352.7 2.364 -0.935 2
Sorghumol 0 426.7 -0.536 -1.665 2
Taraxerol -2 426.72 -0.455 -1.908 2

Hydroxyfriedelanone 0 442.72 -1.295 -1.197 2

Table 4: Pharmacokinetic Properties of the selected Phytoconstituents.

Identification of Phyto-Targets and Disease 
Targets

A total of 145 targets of the phytochemicals were 
identified by entering the canonical SMILES by giving input 
in the databases like SwissTargetPrediction and BindingDB. 
A total of 1010 targets of anxiety and 1169 targets of epilepsy 
were identified with the help of the DisGeNET database.

Identification of Common Targets

A total of 38 common targets for anxiety were identified 
between the total targets of the disease and the total targets 

identified for all the phytoconstituents. A total of 46 common 
targets for anxiety were identified between the total targets 
of the disease and the total targets identified for all the 
phytoconstituents. These common targets were identified 
with the help of Venny 2.1.0 online tool which helps in 
analysing Venn diagrams for analysing the connections 
between various datasets. The results are given in figure 6 
and 7. and the list of common targets is given in the tables 
5 and 6.
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Figure 6: Venn Diagram showing the number of anxiety 
targets, Phyto-targets and the common targets between 
the Disease and Phyto-targets.

Figure 7: Venn Diagram showing the number of epilepsy 
targets, Phyto-targets and the common targets between 
the Disease and Phyto-targets.

SERPINE1 DAO ADORA2A HDAC2 TLR9
GABRA1 PTGS2 SHBG MMP12 EDNRA

ESR2 ESR1 GABRA4 P2RX7 CSF1R
SRC MAOA OPRM1 DYRK1A ACHE

CNR2 CDK5 PIK3CA CAMKK2 GABRA5
FLT4 CES2 SLC6A2 INSRR MAOB

GSK3B GABRA2 SLC6A4 GABRA6
GSR GABRA3 MAPK3 SCN9A

Table 5: List of common targets for anxiety.

GABRA1 ESR1 HIF1A PRKCD ERN1
CNR2 CDK5 GABRA4 PIK3CD MAPK8
INSR GABRA2 PIK3CG PIK3CB MAPK10
EGFR GABRA3 PIK3CA CDK1 HSP90AA1

GSK3B ADORA1 SLC6A4 DYRK1A SCN9A
AKT1 ADORA2A MTOR CAMKK2 DPP4

BACE1 SLC5A2 RELA CXCR2 CASP3
BRAF ADK HDAC2 NTRK1 CSF1R
PTGS2 SHBG GABRA5 HSP90AB1 GABRA6
ACHE

Table 6: List of common targets for epilepsy.

Building of the Target Network 

The 97 targets identified with the help of Venny 2.1.0 
tool were added to the STRING Database to obtain the PPI 

network. The results are given in the figures 8 and 9. The 
PPI network helps in understanding interactions between 
different proteins and their functional relationships.
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Figure 8: The protein-protein interaction of the common targets of Anxiety.

Proteins are represented by circular nodes in the PPI 
diagram and their interactions are represented by lines 
called edges. The purple edges represent interactions 
determined by using curated databases and pink edges 
represent experimentally determined protein-protein 
interactions. The green, red and blue edges represent 

predicted determined protein-protein interactions based on 
gene neighbourhood, gene fusions and gene co-occurrence 
respectively. The yellow and black edges represent protein-
protein interactions based on text mining and co-expression 
respectively.

Figure 9: The protein-protein interaction of the common targets of Epilepsy.
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Proteins are represented by circular nodes in the PPI 
diagram and their interactions are represented by lines 
called edges. The purple edges represent interactions 
determined by using curated databases and pink edges 
represent experimentally determined protein-protein 
interactions. The green, red and blue edges represent 
predicted determined protein-protein interactions based on 
gene neighbourhood, gene fusions and gene co-occurrence 
respectively. The yellow and black edges represent protein-
protein interactions based on text mining and co-expression 
respectively.

Topological Analysis

Top 10 proteins were identified from the 38 and 
46 common proteins for anxiety and epilepsy through 

topological analysis with the help of Cytoscape software. 
The degree and betweenness centrality of top 10 proteins 
were assessed using CytoNCA plugin of cytoscape software. 
GABAR1 was found to have highest degree (26) and 
betweenness centrality (2269.54), followed by GABAR6 
with degree value of 18 and betweenness centrality value of 
897.89 respectively for anxiety. GABAR1 was found to have 
highest degree (32) and betweenness centrality (338.04), 
followed by PRKCD with degree value of 29 and betweenness 
centrality value of 258.19 respectively for epilepsy. The 
results are given in the table 7 and table 8 and in figures 10 
and 11.

Protein Degree Betweenness Centrality
GABRA1 26 2269.54
GABRA6 18 897.89

INSRR 15 400.56
SLC6A4 13 374.6

SNCA 13 265.12
GABRA1 12 201.79

ESR2 11 159.32
MCL1 11 417.25
SHBG 8 598.32
CDK5 8 89.12

Table 7: Topological analysis of common targets of anxiety using Cytoscape Software.

Figure 10: Relationship between Degree and Betweenness centrality of common targets in anxiety.

https://medwinpublishers.com/APCT/


Advances in Pharmacology and Clinical Trials
22

Mujeebuddin CS and Suresh. Investigate the Anticonvulsant and Neuroprotective Effects of 
Commercially Available Humid Acid by Utilizing both In Silico and In Vitro Approaches. Adv in 
Phar & Clin Tria 2026, 11(1): 000259.

Copyright©  Mujeebuddin CS and Suresh.

Protein Degree Betweenness Centrality
GABRA1 32 338.04
PRKCD 29 258.19
SHBG 27 162.09
CNR2 27 142.74

SLC5A2 24 131.16
ACHE 24 118.07

GABRA5 24 109.82
HK1 24 95.04

ERN1 23 94.67
HDAC2 20 64.28

Table 8: Topological analysis of common targets of epilepsy using Cytoscape Software.

Figure 11: Relationship between Degree and Betweenness centrality of common targets in anxiety.

Gene Ontology (GO) Enrichment Analysis 

The Gene Ontology (GO) enrichment analysis was done 
with the help of FunRich software. The top 10 proteins 
that were identified were involved in a variety of cellular 
components (CC), biological processes (BP) and molecular 
functions (MF). In the case of biological processes (BP), 
the top proteins were involved in signal transduction, 
cell communication, metabolism energy pathways 

neurotransmitter metabolism and transport. For cellular 
components, the top 10 targets were found to be enriched 
in mitochondrial outer membrane, mitochondrial envelope, 
basal lamina, plasma membrane and synaptic vesicle 
membrane. In the case of molecular functions (MF), the 
targets were found to be associated with receptor activity, 
hydrolase activity, ion channel activity and extracellular 
ligand gated ion channel activity. The results are given in 
figures 12-14.
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Figure 12: Biological Process of top 10 Selected Targets.

Figure 13: Cellular Component of top 10 Selected Targets.

Figure 14: Cellular Component of top 10 Selected Targets.
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Pathway Analysis

The pathway enrichment analysis was done with the 
help of Reactome software. The pathway analysis revealed 
that the top proteins were involved in activation of GABA A 
receptors. Gamma aminobutyric acid (GABA) receptors are 
the major inhibitory receptors in human synapses. They are 
of two types. GABA A receptors are fast-acting ligand gated 
chloride ion channels that mediate membrane depolarization 
and thus inhibit neurotransmitter release. GABA B receptors 

are slow acting metabotropic Gprotein coupled receptors 
that act via the inhibitory action of their Galpha/Go subunits 
on adenylate cyclase to attenuate the actions of PKA. In 
addition, their Gbeta/gamma subunits interact directly 
with N and P/Q Ca2+ channels to decrease the release of 
Ca2+. GABA B receptors also interact with Kir3K+ channels 
and increase the influx of K+, leading to cell membrane 
hyperpolarization and inhibition of channels such as NMDA 
receptors. The pathway is given in figure 15 and 16.

Figure 15: Pathway Analysis of common Proteins for anxiety.

Figure 16: Pathway Analysis of common Proteins for epilepsy.

Molecular Docking

Molecular Docking studies were done for the top 17 
phytoconstituents present in Phyllanthus reticulatus: humic 
acid, fulvic acid, methyl gallate, betulinic acid, botulin, 
pinoresinol, corilagin, syringaresinol, epifriedelanol, 
β-sitosterol, ellagic acid, macranthoside A, lyoniresinol, 
methylellagic acid, havetrichoside A, havetrichoside C and 

carthomoside A. The phytoconstituents that showed more 
than 2 violations for Lipinski’s rule were not used for further 
studies. The above ligands were docked against 6X3X protein 
Schrodinger Suite software version 13.1. The dock score for 
the ligand, havetrichoside C was found to better than the 
other ligands. The results of molecular docking are presented 
in the table 9 and the 2D interactions are represented in the 
figure 17. 
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Phytoconstituent g-score

(Kcal/mol)

Havetrichoside C -8.54772
Havetrichoside A -7.06173

Methyl gallate -5.21619
Carthomisde A1 -4.95656

Ellagic acid -4.69665
Fulvic acid -4.55037
Pinoresinol -4.50028

Methyl ellagic acid -4.27449
Syringaresinol -3.54985
Betullinic acid -2.93162

Betulin -2.43139
Humic acid -2.12076

Corilagin -1.60855
Epifriedelanol -1.19869
Β-Sitosterol -0.77514

Macronthoside A -0.68591
Lyoniresinol -0.54896

Diazepam -7.57729

Table 9: Dock score of the selected phytoconstituents.

                            
Havetrichoside C                                                                                             Havetrichoside A
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Carthomoside A Methyl Gallate

Ellagic Acid

Figure 17: 2D interaction diagram of phytoconstituents with the selected target.

MM/GBSA 

The MM/GBSA studies were performed for all the 
protein- ligand complexes using the Schrodinger software 
version 13.1. The results showed havetrichoside C to be better 

than other ligands. The MM/GBSA result of havetrichoside 
C against proteins 6X3X was found to be –56.19 kcal/mol 
compared to the standard (diazepam) value of -48.52 kcal/
mol. The MM/GBSA results are presented in the table 10.
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Phytoconstituent g-score
(Kcal/mol)

Havetrichoside C -56.19244526
Havetrichoside A -51.02232839

Methyl gallate -37.24929666
Carthomisde A1 -48.33516714

Ellagic acid -54.5902698
Fulvic acid -35.2281953
Pinoresinol -41.84076116

Methyl ellagic acid -54.82350247
Syringaresinol -36.16180423
Betullinic acid -42.52459809

Betulin -36.01424758
Humic acid -33.41592773

Corilagin -19.97457074
Epifriedelanol -40.78280735
Β-Sitosterol -9.755844956

Macronthoside A -28.45980336
Lyoniresinol -35.03162511

Diazepam -48.52823893

Table 10: Free energy score of the selected phytoconstituents.

Molecular Dynamics

Ligand- Protein complex of havetrichoside C with 6X3X 
were studied using Desmond Schrodinger Suite software 
version 13.1. A constant-temperature, constant-pressure 
ensemble (NPT) with an atmospheric pressure was set to last 
for 100 ns at 310 K and 1.013 bar to run the MD simulation. 
OPLS4 force field was used to develop the complexes. The 
RMSD of the havetrichoside C- 6X3X complex had converged 
approximately around 15ns and thereafter there is no shift in 
the RMSD value. The RMSD results are represented in figure 
18.

 The RMSF values fluctuate along the protein sequence, 
indicating variations in the flexibility or mobility of different 
residues. Regions with higher RMSF values suggest greater 
flexibility, while regions with lower RMSF values indicate 
more rigid or stable conformations. Peaks in the RMSF 
curve represent residues with significant fluctuations, 
likely indicating regions of increased flexibility or structural 
dynamics. Valleys in the RMSF curve correspond to residues 
with relatively lower fluctuations, suggesting regions of 
stability or constrained motion. The amino acids from 
250 to 300 are involved in formation of stable interactions 

between the protein and the ligands. The RMSF results are 
represented in figure19.

Different types of interactions are shown between the 
protein and ligand. The important interactions are: VAL-258: 
Shows a significant fraction of Hydrophobic interactions.
MET-261: Exhibits a high proportion of Hydrophobic and 
H-bond interactions.THR-262: Predominantly involved 
in Hydrophobic interactions with a moderate fraction of 
H-bonds. ASN-265: Primarily engaged in Hydrophobic 
and Ionic interactions. THR-266: Appears to participate in 
Hydrophobic, Ionic, and Water bridge interactions. ARG-269: 
Demonstrates a considerable fraction of Ionic interactions. 
GLU-270: Involved in Ionic and Hydrophobic interactions. 
ASP-282: Shows Hydrophobic and Ionic interactions. LEU-
285: Engaged mainly in Hydrophobic interactions. MET-
286: Indicates Hydrophobic interactions. PHE-289: Shows 
a fraction of Hydrophobic interactions. The protein-ligand 
contacts are represented in figure 20.

The ligand molecule has various functional groups, such 
as hydroxyl (OH) and carbonyl (C=O) groups, which can form 
interactions with specific amino acid residues of the protein. 
Aminoacid residue, ASN 265 maintains a stable interaction 
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with the ligand for 66 % of the simulation time. Thr 266 and 
Thr 262 maintain stable interactions for 42 % and 35 % of 

the simulation time. The results are represented in figure 21.

Figure 18: Protein Ligand RMSD graph of havetrichoside C and 6X3X.

Figure 19: Protein RMSF graph of havetrichoside C and 6X3X.

Figure 20: Protein-Ligand Contacts of havetrichoside C with 6X3X.
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Figure 21: Ligand - Protein Contacts of havetrichoside C with 6X3X.

Discussion

The aim of the current study is to evaluate the anti-
anxiety and anti-epileptic activity of Phyllanthus reticulatus 
through network pharmacology and molecular modelling 
approach.

Network pharmacology is a distinctive in-silico 
approach that targets multiple proteins involved in the 
pathogenesis of a disease instead of a single protein. It 
has enabled a paradigm shift from the classical existing 
‘one disease–one target–one drug’ dogma to the current 
‘multicomponent, multi-target’ approach [53,54]. It aims 
to comprehend the ways in which biological networks are 
affected by pharmaceuticals and how these networks react 
to these perturbations. It has become a vital technique in the 
search for new drugs and can be applied to discover novel 
therapeutic targets, forecast drug effectiveness and toxicity, 
and enhance drug combinations. Network pharmacology, as 
opposed to classical pharmacology, focuses on the network 
level interactions between drugs and biological systems to 
provide an understanding of the mechanism of action of 
drug.

Phyllanthus reticulatus, a medicinal plant, exhibits 
a plethora of pharmacological activities. Its petroleum 
ether and ethanolic leaf extracts demonstrated significant 
antidiabetic effects in alloxan-treated mice, particularly at 
1000 mg/kg dose [55]. Moreover, the leaves showed potent 
in vitro antiplasmodial activity against chloroquine-sensitive 
and chloroquine-resistant strains of Plasmodium falciparum 
[56]. Additionally, the aqueous extract of plant’s aerial 

parts exhibited hypocholesterolemic activity by reducing 
cholesterol levels and improving HDL cholesterol [57]. Its 
methanolic stem bark extract displayed antimicrobial and 
cytotoxic properties [58], while the ethanolic extract of aerial 
parts showed hepatoprotective activity against CCl4- induced 
liver damage in rats [59]. Furthermore, the leaf extracts 
exhibited significant antibacterial [60], antinociceptive, 
anti-hyperglycemic [61], analgesic, and anti-inflammatory 
activities [62]. The entire plant’s methanolic and ethanolic 
extracts also showed potent antioxidant activity [63]. Finally, 
two fractions of the ethanolic extract displayed anti-hepatitis 
B viral activity, suggesting the plant’s potential in treating 
various diseases [64].

The literature survey and data mining revealed the 
presence of 25 active phytoconstituents in Phyllanthus 
reticulatus. The 25 phytoconstituents are: humic acid, fulvic 
acid, methyl gallate, betulinic acid, botulin, pinoresinol, 
corilagin, syringaresinol, epifriedelanol, β-sitosterol, 
ellagic acid, macranthoside A, lyoniresinol, methylellagic 
acid, havetrichoside A, havetrichoside C, carthomoside A, 
Octacosanol, Tricosanol, Friedelin, Glochidonol, Pentacosane, 
Sorghumol, Taraxerol and Hydroxyfriedelanone [65]. 

The phytoconstituents of Phyllanthus reticulatus were 
subjected to prediction of pharmacokinetic properties 
like drug-likeliness, blood-brain barrier penetration, 
partition coefficient etc. Among the 25 phytoconstituents 
of Phyllanthus reticulatus, 17 compounds exhibited 
favorable pharmacokinetic properties. These 17 
phytoconstituents were used for further molecular docking, 
MM GBSA and molecular dynamics study to identify the best 
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phytoconstituents that could be effective in the management 
of epilepsy and anxiety. The 17 phytoconstituents that 
exhibited favorable pharmacokinetic properties are: humic 
acid, fulvic acid, methyl gallate, betulinic acid, botulin, 
pinoresinol, corilagin, syringaresinol, epifriedelanol, 
β-sitosterol, ellagic acid, macranthoside A, lyoniresinol, 
methylellagic acid, havetrichoside A, havetrichoside C and 
carthomoside A.

A total of 145 targets of the phytochemicals were 
identified by entering the canonical SMILES by giving input 
in the databases like SwissTargetPrediction and BindingDB. 
A total of 1010 targets of anxiety and 1169 targets of 
epilepsy were identified with the help of the DisGeNET 
database. A total of 38 common targets for anxiety were 
identified between the total targets of the disease and the 
total targets identified for all the phytoconstituents. A total of 
46 common targets for anxiety were identified between the 
total targets of the disease and the total targets identified for 
all the phytoconstituents. The most important therapeutic 
targets in epilepsy and anxiety were identified with the 
help of topological parameters like degree centrality and 
betweenness centrality. Degree centrality measures the 
number of connections a node (protein/target) makes with 
other nodes in a network. Betweenness centrality determines 
the influence of a node (protein/target) in controlling the 
interaction between a pair of nodes (protein/target) passing 
through this node in the network. Closeness centrality 
measures the inverse of average distance of a node from all 
other nodes in a network. It is widely accepted that nodes 
with higher degree, betweenness and closeness centrality 
values may represent important targets and play a crucial 
role in a biological network [66,67]. Topological analysis 
revealed that GABAA receptor to be the most important 
target involved in the pathogenesis of anxiety and epilepsy.

The pathway enrichment analysis was done with the 
help of Reactome software. The pathway analysis revealed 
that the top proteins were involved in activation of GABA A 
receptors. Gamma aminobutyric acid (GABA) receptors are 
the major inhibitory receptors in human synapses [68,69]. 
They are of two types. GABA A receptors are fast-acting 
ligand gated chloride ion channels that mediate membrane 
depolarization and thus inhibit neurotransmitter release. 
GABA B receptors are slow acting metabotropic Gprotein 
coupled receptors that act via the inhibitory action of their 
Galpha/Go subunits on adenylate cyclase to attenuate the 
actions of PKA. In addition, their Gbeta/gamma subunits 
interact directly with N and P/Q Ca2+ channels to decrease 
the release of Ca2+ [70,71]. GABA B receptors also interact 
with Kir3K+ channels and increase the influx of K+, leading to 
cell membrane hyperpolarization and inhibition of channels 
such as NMDA receptors [72,73].

The molecular docking, MMGBSA and molecular 

dynamics studies showed that havetrichoside c exhibits 
better binding affinity and stability with GABA receptor 
compared to other phytoconstituents present in Phyllanthus 
reticulatus. Havetrichoside C, a naturally occurring 
compound that exhibits a range of bioactive properties, 
making it a subject of interest in drug discovery and 
development. Studies have shown that havetrichoside C 
possesses potent antioxidant properties, which can help 
combat oxidative stress-induced damage in cells and tissues. 
Additionally, it has been found to have anti-inflammatory 
effects, potentially offering therapeutic benefits in various 
inflammatory conditions. Furthermore, havetrichoside C has 
demonstrated promising anticancer activity in preclinical 
studies. Research suggests that it may inhibit the growth 
of cancer cells and induce apoptosis, making it a potential 
candidate for cancer treatment. Moreover, this compound 
has been investigated for its neuroprotective effects, 
showing potential in protecting neurons from damage and 
degeneration. Such properties could have implications in the 
treatment of neurodegenerative diseases like Alzheimer’s 
and Parkinson’s.

Xian-wen Ye, et al. conducted a study to analyze 
the pharmacologic mechanisms of Coptidis rhizoma 
for the treatment of Alzheimer’s disease using network 
pharmacology approach. They found STAT3 to be a major 
target of Coptidis rhizoma and concluded that inhibition 
of STAT3 would be a promising treatment for Alzheimer’s 
disease. A study conducted by Yangwen Luo et al. looked 
into the therapeutic potential of Sceletium tortuosum for 
the treatment of neurodegenerative disorders, including 
Alzheimer’s disease. The findings revealed that MAOB might 
be a target of Sceletium tortuosum and that its inhibition 
might raise the levels of dopamine and other monoamines 
in the brain, potentially enhancing cognitive function 
in Alzheimer’s disease. Jarrel J, et al. employed network 
pharmacology approach to look at the molecular causes of 
Alzheimer’s disease and to find prospective therapeutic 
targets in TCM. The findings revealed that HDAC2 could be 
a possible target and that blocking it could halt neuronal 
degeneration and cognitive impairment [73]. 

In diseases with multifactorial origins like epilepsy 
and anxiety, combination therapy has been proven to be 
more efficacious than monotherapy. The current study 
has identified that havetrichoside c could be effective in 
prevention and treatment of epilepsy and anxiety through 
activation of GABA receptors involved in the pathogenesis of 
epilepsy and anxiety. 

Conclusion 

The results of the current study reveal that 
phytoconstituents can serve as excellent candidates in 
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the management of epilepsy and anxiety by modifying the 
functions of GABA receptors. Further in vivo studies using 
animal models are required to confirm the therapeutic 
potential of the havetrichoside c in the prevention and 
treatment of epilepsy and anxiety.

References

1.	 WHO (2014) Epilepsy.

2.	 MedicineNet, Seizures: Symptoms and Types

3.	 Neeru, Kashyap S, Sharma N (2016) Study of 
antiepileptic activity of Roylea elegans wall (aerial 
parts). World Journal of Pharmacy and Pharmaceutical 
Sciences 5(7): 439-453.   

4.	 Shodh Ganga: a reservoir of Indian theses

5.	 Tripathi KD, Essentials of medical pharmacology, Jaypee 
brothers medical publishers(p) ltd, 6th (edn), 401-402 

6.	 Epilepsy Foundation 

7.	 Loscher W (2011) Critical review of current animal 
models of seizures and epilepsy used in the discovery 
and development of new antiepileptic drugs. EJOE 
20(5): 359-368

8.	 Gupta B (2012) Medicinal plants as agent of 
anticonvulsant activity. Int J Res Dev Pharm L Sci 1(3): 
126-134 

9.	 Goyal RK (2007) Dessari and Gandhi’s elements of 
pharmacology. 17th(Edn.), BS Shah Prakashan, pp: 288-
289. 

10.	 Kumar KS, Kota K, Jarinabanu T, Tahashildar J, 
Ragavendhra P, et al. (2015) Antiepileptic activity of 
ethanolic extract of Biophytum sensitivum (L.) DC. In 
Animal models. Int J Curr Res Aca Rev 3(7): 23-30 .

11.	 Rang HP, Dale MM, Ritter JM, Flower RJ, Rang and Dale’s 
pharmacology, Elsevier publications, 7th (edn) 540-543 

12.	 Epilepsy in the WHO Eastern Mediterranean Region

13.	 Medical News Today

14.	 Epilepsy 

15.	 https://www.med.unc.edu/neurology/files/child.pdf/
Epilepsy%20BASICORE.pdf 

16.	 Harvey RA, Champe P (2009) Lipincott’s illustrated 
review: Pharmacology. 4th (Edn.), Lippincott Williams, 

Philadelphia, USA, pp: 564.

17.	 Avanthi E, Kumar P, Lokesh BN, Guruprasad Y. (2016);  
The study of antiepileptic activity of clove oil by 
MES model in mice.  Indian Journal of Pharmacy and 
Pharmacology 3(3): 103-107   

18.	 Nirmala D (2015) Studies on anticonvulsant activity of 
Annacyclus pyrethrum in albino   mice. Asian J Pharm 
Clin Res 8(4): 178-187 

19.	 Pitchaiah G, Anusha VL, Hemalatha CH, Anil Kumar Y, 
Sravani K, et al. (2015) Anxiolytic and anticonvulsant 
activity of methanolic extract of Allium cepa Linn 
(Onion) bulbs in Swiss albino mice. Journal of 
Pharmacognosy and Phytochemistry 4(2): 131-134 

20.	 Santilna KS, Mahesh NM, Suresh J (2014) Anticonvulsant 
Activity Study of Artemisia nilagirica. IJPPR 6(4): 826-
830 

21.	 Sutar RC, Kasture SB, Kalaichelvan VK (2014) Evaluation 
of anticonvulsant activity of leaf extracts of Holoptelea 
integrifolia (roxb) planch in experimental animals. Int J 
Pharm Pharm Sci 6(4): 308-311. 

22.	 Pathan D, Ambavade S (2014) Anticonvulsant activity 
ethanolic extract of Picrorhiza kurroa. Pharmacophore 
5(1): 141-146 

23.	 Varma GG, Mathai BK, Das K, Gowda G, Rammohan 
S, et al  (2014) Evaluation of antiepileptic activity of 
methanolic leaves extract of Tragia involucrata Linn. in 
mice. International Letters of Natural Sciences 17(1): 
167-179. 

24.	 Modaresi M, Pouriyanzadeh A, Asadi-Saman M (2014) 
Antiepileptic activity of hydroalcoholic extract of basil 
in mice. J HerbMed Pharmacol 3(1): 57-60 

25.	 Chinchawade AB, Deshmukh DB, Gaikwad DD, 
Grampurohit ND (2013). Anticonvulsant Activity 
of Chloroform Extract of Bark & Root of Erythrina 
variegata L. IJPCR  5(1): 23-25. 

26.	 Abubakar K, Ugwah-Oguejiofor CJ, Usman MN, 
Abubakar SB, Abdulkadir R et al. (2013). Evaluation 
of the Anticonvulsant Effect of the Methanol Extract of 
Evolvulus alsinoides in Mice. Sch. Acad. J. Pharm 2(6): 
436-441.

27.	 Anovadiya AP, Sanmukhan JJ, Vadgama VK, Tripath 
CB (2013) Evaluation of antiepileptic and memory 
retention activity of Curcumin perse and in combination 
with antiepileptic drugs. Asian J Pharm Clin Res 6(2): 
145-148.

https://medwinpublishers.com/APCT/
https://www.who.int/news-room/fact-sheets/detail/epilepsy
https://www.medicinenet.com/seizures_symptoms_and_types/article.htm
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&scioq=Study+of+antiepileptic+activity+of+Roylea+elegans+wall+%28aerial+parts%29&q=Study+of+antiepileptic+activity+of+Roylea+elegans+wall+%28aerial+parts%29&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&scioq=Study+of+antiepileptic+activity+of+Roylea+elegans+wall+%28aerial+parts%29&q=Study+of+antiepileptic+activity+of+Roylea+elegans+wall+%28aerial+parts%29&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&scioq=Study+of+antiepileptic+activity+of+Roylea+elegans+wall+%28aerial+parts%29&q=Study+of+antiepileptic+activity+of+Roylea+elegans+wall+%28aerial+parts%29&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&scioq=Study+of+antiepileptic+activity+of+Roylea+elegans+wall+%28aerial+parts%29&q=Study+of+antiepileptic+activity+of+Roylea+elegans+wall+%28aerial+parts%29&btnG=
https://shodhganga.inflibnet.ac.in/
https://www.epilepsy.com/
https://www.seizure-journal.com/article/S1059-1311(11)00012-4/fulltext
https://www.seizure-journal.com/article/S1059-1311(11)00012-4/fulltext
https://www.seizure-journal.com/article/S1059-1311(11)00012-4/fulltext
https://www.seizure-journal.com/article/S1059-1311(11)00012-4/fulltext
https://pesquisa.bvsalud.org/portal/resource/pt/sea-148356
https://pesquisa.bvsalud.org/portal/resource/pt/sea-148356
https://pesquisa.bvsalud.org/portal/resource/pt/sea-148356
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antiepileptic+activity+of+ethanolic+extract+of+Biophytum+sensitivum+%28L.%29+DC.+In+Animal+models.+Int.J.Curr.Res.Aca.Rev&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antiepileptic+activity+of+ethanolic+extract+of+Biophytum+sensitivum+%28L.%29+DC.+In+Animal+models.+Int.J.Curr.Res.Aca.Rev&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antiepileptic+activity+of+ethanolic+extract+of+Biophytum+sensitivum+%28L.%29+DC.+In+Animal+models.+Int.J.Curr.Res.Aca.Rev&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antiepileptic+activity+of+ethanolic+extract+of+Biophytum+sensitivum+%28L.%29+DC.+In+Animal+models.+Int.J.Curr.Res.Aca.Rev&btnG=
https://applications.emro.who.int/dsaf/dsa1039.pdf
https://www.medicalnewstoday.com/
https://en.wikipedia.org/wiki/Epilepsy
https://www.med.unc.edu/neurology/files/child.pdf/Epilepsy%20BASICORE.pdf
https://www.med.unc.edu/neurology/files/child.pdf/Epilepsy%20BASICORE.pdf
https://elib.must.ac.ug/bib/5699
https://elib.must.ac.ug/bib/5699
https://elib.must.ac.ug/bib/5699
https://indianjournals.com/article/ijpp4-3-3-001
https://indianjournals.com/article/ijpp4-3-3-001
https://indianjournals.com/article/ijpp4-3-3-001
https://indianjournals.com/article/ijpp4-3-3-001
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=.++Studies+on+anticonvulsant+activity+of+Annacyclus+pyrethrum+in+albino+++mice&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=.++Studies+on+anticonvulsant+activity+of+Annacyclus+pyrethrum+in+albino+++mice&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=.++Studies+on+anticonvulsant+activity+of+Annacyclus+pyrethrum+in+albino+++mice&btnG=
https://www.sid.ir/paper/699758/en
https://www.sid.ir/paper/699758/en
https://www.sid.ir/paper/699758/en
https://www.sid.ir/paper/699758/en
https://www.sid.ir/paper/699758/en
https://www.researchgate.net/profile/Santilna_Ks/publication/275649201_Anticonvulsant_Activity_Study_of_Artemisia_nilagirica/links/554247120cf24107d3942fbc.pdf
https://www.researchgate.net/profile/Santilna_Ks/publication/275649201_Anticonvulsant_Activity_Study_of_Artemisia_nilagirica/links/554247120cf24107d3942fbc.pdf
https://www.researchgate.net/profile/Santilna_Ks/publication/275649201_Anticonvulsant_Activity_Study_of_Artemisia_nilagirica/links/554247120cf24107d3942fbc.pdf
https://www.academia.edu/117706126/EVALUATION_OF_ANTIOXIDANT_ACTIVITY_OF_LEAF_EXTRACTS_OF_HOLOPTELEA_INTEGRIFOLIA_ROXB_PLANCH_Research_Article
https://www.academia.edu/117706126/EVALUATION_OF_ANTIOXIDANT_ACTIVITY_OF_LEAF_EXTRACTS_OF_HOLOPTELEA_INTEGRIFOLIA_ROXB_PLANCH_Research_Article
https://www.academia.edu/117706126/EVALUATION_OF_ANTIOXIDANT_ACTIVITY_OF_LEAF_EXTRACTS_OF_HOLOPTELEA_INTEGRIFOLIA_ROXB_PLANCH_Research_Article
https://www.academia.edu/117706126/EVALUATION_OF_ANTIOXIDANT_ACTIVITY_OF_LEAF_EXTRACTS_OF_HOLOPTELEA_INTEGRIFOLIA_ROXB_PLANCH_Research_Article
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Anticonvulsant+activity+ethanolic+extract+of+Picrorhiza+kurroa&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Anticonvulsant+activity+ethanolic+extract+of+Picrorhiza+kurroa&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Anticonvulsant+activity+ethanolic+extract+of+Picrorhiza+kurroa&btnG=
https://agro.icm.edu.pl/agro/element/bwmeta1.element.agro-a9bdc010-4261-46c4-805f-09b8305cb127
https://agro.icm.edu.pl/agro/element/bwmeta1.element.agro-a9bdc010-4261-46c4-805f-09b8305cb127
https://agro.icm.edu.pl/agro/element/bwmeta1.element.agro-a9bdc010-4261-46c4-805f-09b8305cb127
https://agro.icm.edu.pl/agro/element/bwmeta1.element.agro-a9bdc010-4261-46c4-805f-09b8305cb127
https://agro.icm.edu.pl/agro/element/bwmeta1.element.agro-a9bdc010-4261-46c4-805f-09b8305cb127
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antiepileptic+activity+of+hydroalcoholic+extract+of+basil+in+mice&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antiepileptic+activity+of+hydroalcoholic+extract+of+basil+in+mice&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antiepileptic+activity+of+hydroalcoholic+extract+of+basil+in+mice&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Anticonvulsant+Activity+of+Chloroform+Extract+of+Bark+%26+Root+of+Erythrina+variegata+L&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Anticonvulsant+Activity+of+Chloroform+Extract+of+Bark+%26+Root+of+Erythrina+variegata+L&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Anticonvulsant+Activity+of+Chloroform+Extract+of+Bark+%26+Root+of+Erythrina+variegata+L&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Anticonvulsant+Activity+of+Chloroform+Extract+of+Bark+%26+Root+of+Erythrina+variegata+L&btnG=
https://www.cabidigitallibrary.org/doi/full/10.5555/20143089450
https://www.cabidigitallibrary.org/doi/full/10.5555/20143089450
https://www.cabidigitallibrary.org/doi/full/10.5555/20143089450
https://www.cabidigitallibrary.org/doi/full/10.5555/20143089450
https://www.cabidigitallibrary.org/doi/full/10.5555/20143089450
https://scholar.google.com/scholar?lookup=0&q=Evaluation+of+antiepileptic+and+memory+retention+activity+of+Curcumin+perse+and+in+combination+with+antiepileptic+drugs&hl=en&as_sdt=0,5
https://scholar.google.com/scholar?lookup=0&q=Evaluation+of+antiepileptic+and+memory+retention+activity+of+Curcumin+perse+and+in+combination+with+antiepileptic+drugs&hl=en&as_sdt=0,5
https://scholar.google.com/scholar?lookup=0&q=Evaluation+of+antiepileptic+and+memory+retention+activity+of+Curcumin+perse+and+in+combination+with+antiepileptic+drugs&hl=en&as_sdt=0,5
https://scholar.google.com/scholar?lookup=0&q=Evaluation+of+antiepileptic+and+memory+retention+activity+of+Curcumin+perse+and+in+combination+with+antiepileptic+drugs&hl=en&as_sdt=0,5
https://scholar.google.com/scholar?lookup=0&q=Evaluation+of+antiepileptic+and+memory+retention+activity+of+Curcumin+perse+and+in+combination+with+antiepileptic+drugs&hl=en&as_sdt=0,5


Advances in Pharmacology and Clinical Trials
32

Mujeebuddin CS and Suresh. Investigate the Anticonvulsant and Neuroprotective Effects of 
Commercially Available Humid Acid by Utilizing both In Silico and In Vitro Approaches. Adv in 
Phar & Clin Tria 2026, 11(1): 000259.

Copyright©  Mujeebuddin CS and Suresh.

28.	 Singh P, Garg VK, Sharma PK, Gupta s (2012) 
Antiepileptic activity of aqueous extract of Tricosanthes 
dioica Roxb. Asian J Plant Sci Res 2 (1): 45-47.

29.	 Saroch V, Hiremath RS, Patil PA (2012) Anticonvulsant 
Activity of Apasmarari rasa – An Experimental Study, 
International Journal of Ayurvedic Medicine 3(1): 48-
52. 

30.	 Garg VK, Paliwal SK (2011) Anticonvulsant activity of 
ethanolic extract of Cynodon dactylon. Der Pharmacia 
Sinica 2 (2): 86-90. 

31.	 Manikkoth S, Deepa B, Joy AE, Rao SN (2011) 
Anticonvulsant activity of Phyllanthus amarus in 
experimental animal models. International Journal of 
Applied Biology and Pharmaceutical Technology 2(4): 
144-147. 

32.	 Babu HB, Mohana LS, Saravana KA (2010) Studies 
on phytochemical and anticonvulsant property 
of Martyniya annua linn. International Journal of 
Phytopharmacology  1(2): 82-86. 

33.	 Vyawahare NS, Bodhankar SL (2009) Anticonvulsant 
Activity of Argyreia speciosa in Mice. Indian Journal of 
Pharmaceutical Sciences 71(2): 131-134. 

34.	 Hegde K, Thakker SP, Joshi AB, Shastry CS, 
Chandrashekhar KS (2009) Anticonvulsant activity of 
Carissa carandas Linn. Root Extract in Experimental 
Mice. Trop J Pharm Res 8 (2): 117-125.

35.	 Buddhadev SG, Buddhadev SS (2017) A complete review 
on ativisha –Aconitum heterophyllum. An International 
Journal of Pharmaceutical Sciences 8(1): 111-114.

36.	 Pahal S, Gupta A, Choudhary P, Chaudhary A, Singh 
S et al. (2021) Network pharmacological evaluation 
of Withania somnifera bioactive phytochemicals 
for identifying novel potential inhibitors against 
neurodegenerative disorder. J Biomol Struct Dyn. 
40(21): 10887-10898.

37.	 Thirumal Kumar D, Shree Devi MS, Udhaya Kumar S, 
Sherlin A, Mathew A, et al. (2022) Understanding the 
activating mechanism of the immune system against 
COVID-19 by Traditional Indian Medicine: Network 
pharmacology approach. In: Advances in Protein 
Chemistry and Structural Biology. Academic Press Inc. 
275-379. 

38.	 Fatriansyah JF, Rizqillah RK, Yandi MY, Fadilah, Sahlan 
M (2022) Molecular docking and dynamics studies on 
propolis sulabiroin-A as a potential inhibitor of SARS-
CoV-2. J King Saud Univ Sci 1: 34(1).

39.	 Yang Y, He Y, Wei X, Wan H, Ding Z, et al. (2022) 
Network Pharmacology and Molecular Docking-Based 
Mechanism Study to Reveal the Protective Effect of 
Salvianolic Acid C in a Rat Model of Ischemic Stroke. 
Front Pharmacol  27: 12

40.	 Wang K, Wang Y, Yan J, Hou C, Zhong X, et al. (2022) 
Network Pharmacology and Molecular Docking 
Integrated Strategy to the Screening of Active 
Components and Mechanisms of Stephaniae Tetrandrae 
Radix on Breast Cancer. Processes 10(11). 

41.	 Zhang M, Yang J, Zhao X, Zhao Y, Zhu S, et al. (2021) 
Network pharmacology and molecular docking study 
on the active ingredients of qidengmingmu capsule for 
the treatment of diabetic retinopathy. Sci Rep 11(1). 

42.	 Li H, Guo L, Ding X, An Q, Wang L et al. (2022) Molecular 
Networking, Network Pharmacology, and Molecular 
Docking Approaches Employed to Investigate the 
Changes in Ephedrae Herba before and after Honey-
Processing. Molecules 27(13).

43.	 Hasan MM, Khan Z, Chowdhury MS, Khan MA, Moni MA, 
et al. (2022) In silico molecular docking and ADME/T 
analysis of Quercetin compound with its evaluation 
of broad-spectrum therapeutic potential against 
particular diseases. Inform Med Unlocked 1: 29. 

44.	 Rajagopal K, Varakumar P, Aparna B, Byran G, Jupudi 
S, et al. (2021) Identification of some novel oxazine 
substituted 9-anilinoacridines as SARS-CoV-2 inhibitors 
for COVID-19 by molecular docking, free energy 
calculation and molecular dynamics studies. J Biomol 
Struct Dyn 39(15): 5551-5562. 

45.	 Bakal RL, Jawarkar RD, Manwar JV, Jaiswal MS, Ghosh A, 
et al. (`2022) Identification of potent aldose reductase 
inhibitors as antidiabetic (Anti-hyperglycemic) agents 
using QSAR based virtual Screening, molecular Docking, 
MD simulation and MMGBSA approaches: Identification 
of potent aldose reductase inhibitors as antidiabetic 
(Anti-hyperglycemic) agents. Saudi Pharmaceutical 
Journal 30(6): 693-710. 

46.	 Thangavel N, Albratty M (2023) Benchmarked 
molecular docking integrated molecular dynamics 
stability analysis for prediction of SARS-CoV-2 papain-
like protease inhibition by olive secoiridoids. J King 
Saud Univ Sci 35(1). 

47.	 Jupudi S, Rajagopal K, Murugesan S, Kumar BK, Raman 
K, et al. (2022) Identification of Papain-Like Protease 
inhibitors of SARS CoV-2 through HTVS, Molecular 
docking, MMGBSA and Molecular dynamics approach. 

https://medwinpublishers.com/APCT/
https://www.academia.edu/25509384/Antiepileptic_activity_of_aqueous_extract_of_Tricosanthes_dioica_Roxb
https://www.academia.edu/25509384/Antiepileptic_activity_of_aqueous_extract_of_Tricosanthes_dioica_Roxb
https://www.academia.edu/25509384/Antiepileptic_activity_of_aqueous_extract_of_Tricosanthes_dioica_Roxb
https://www.researchgate.net/profile/Vikas-Saroch/publication/260122337_Anticonvulsant_Activity_of_Apasmarari_rasa_-_An_Experimental_Study/links/00b7d52fa1a5de5fdd000000/Anticonvulsant-Activity-of-Apasmarari-rasa-An-Experimental-Study.pdf
https://www.researchgate.net/profile/Vikas-Saroch/publication/260122337_Anticonvulsant_Activity_of_Apasmarari_rasa_-_An_Experimental_Study/links/00b7d52fa1a5de5fdd000000/Anticonvulsant-Activity-of-Apasmarari-rasa-An-Experimental-Study.pdf
https://www.researchgate.net/profile/Vikas-Saroch/publication/260122337_Anticonvulsant_Activity_of_Apasmarari_rasa_-_An_Experimental_Study/links/00b7d52fa1a5de5fdd000000/Anticonvulsant-Activity-of-Apasmarari-rasa-An-Experimental-Study.pdf
https://www.researchgate.net/profile/Vikas-Saroch/publication/260122337_Anticonvulsant_Activity_of_Apasmarari_rasa_-_An_Experimental_Study/links/00b7d52fa1a5de5fdd000000/Anticonvulsant-Activity-of-Apasmarari-rasa-An-Experimental-Study.pdf
https://www.cabidigitallibrary.org/doi/full/10.5555/20113324824
https://www.cabidigitallibrary.org/doi/full/10.5555/20113324824
https://www.cabidigitallibrary.org/doi/full/10.5555/20113324824
https://pesquisa.bvsalud.org/portal/resource/pt/sea-163611
https://pesquisa.bvsalud.org/portal/resource/pt/sea-163611
https://pesquisa.bvsalud.org/portal/resource/pt/sea-163611
https://pesquisa.bvsalud.org/portal/resource/pt/sea-163611
https://pesquisa.bvsalud.org/portal/resource/pt/sea-163611
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Studies+on+phytochemical+and+anticonvulsant+property+of+Martyniya+annua+linn.+International+Journal+of+Phytopharmacology&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Studies+on+phytochemical+and+anticonvulsant+property+of+Martyniya+annua+linn.+International+Journal+of+Phytopharmacology&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Studies+on+phytochemical+and+anticonvulsant+property+of+Martyniya+annua+linn.+International+Journal+of+Phytopharmacology&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Studies+on+phytochemical+and+anticonvulsant+property+of+Martyniya+annua+linn.+International+Journal+of+Phytopharmacology&btnG=
https://pmc.ncbi.nlm.nih.gov/articles/PMC2839397/
https://pmc.ncbi.nlm.nih.gov/articles/PMC2839397/
https://pmc.ncbi.nlm.nih.gov/articles/PMC2839397/
https://utoronto.scholaris.ca/items/f29af6bc-9e48-4191-88f9-a2c71d4ee664
https://utoronto.scholaris.ca/items/f29af6bc-9e48-4191-88f9-a2c71d4ee664
https://utoronto.scholaris.ca/items/f29af6bc-9e48-4191-88f9-a2c71d4ee664
https://utoronto.scholaris.ca/items/f29af6bc-9e48-4191-88f9-a2c71d4ee664
https://www.researchgate.net/profile/Sandip-Buddhadev/publication/318489858_A_COMPLETE_REVIEW_ON_ATIVISHA_-ACONITUM_HETEROPHYLLUM/links/596da188458515d9265fd4fa/A-COMPLETE-REVIEW-ON-ATIVISHA-ACONITUM-HETEROPHYLLUM.pdf
https://www.researchgate.net/profile/Sandip-Buddhadev/publication/318489858_A_COMPLETE_REVIEW_ON_ATIVISHA_-ACONITUM_HETEROPHYLLUM/links/596da188458515d9265fd4fa/A-COMPLETE-REVIEW-ON-ATIVISHA-ACONITUM-HETEROPHYLLUM.pdf
https://www.researchgate.net/profile/Sandip-Buddhadev/publication/318489858_A_COMPLETE_REVIEW_ON_ATIVISHA_-ACONITUM_HETEROPHYLLUM/links/596da188458515d9265fd4fa/A-COMPLETE-REVIEW-ON-ATIVISHA-ACONITUM-HETEROPHYLLUM.pdf
https://www.tandfonline.com/doi/abs/10.1080/07391102.2021.1951355
https://www.tandfonline.com/doi/abs/10.1080/07391102.2021.1951355
https://www.tandfonline.com/doi/abs/10.1080/07391102.2021.1951355
https://www.tandfonline.com/doi/abs/10.1080/07391102.2021.1951355
https://www.tandfonline.com/doi/abs/10.1080/07391102.2021.1951355
https://www.tandfonline.com/doi/abs/10.1080/07391102.2021.1951355
https://www.sciencedirect.com/science/chapter/bookseries/pii/S1876162321000882
https://www.sciencedirect.com/science/chapter/bookseries/pii/S1876162321000882
https://www.sciencedirect.com/science/chapter/bookseries/pii/S1876162321000882
https://www.sciencedirect.com/science/chapter/bookseries/pii/S1876162321000882
https://www.sciencedirect.com/science/chapter/bookseries/pii/S1876162321000882
https://www.sciencedirect.com/science/chapter/bookseries/pii/S1876162321000882
https://www.sciencedirect.com/science/chapter/bookseries/pii/S1876162321000882
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Molecular+docking+and+dynamics+studies+on+propolis+sulabiroin-A+as+a+potential+inhibitor+of+SARS-CoV-2&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Molecular+docking+and+dynamics+studies+on+propolis+sulabiroin-A+as+a+potential+inhibitor+of+SARS-CoV-2&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Molecular+docking+and+dynamics+studies+on+propolis+sulabiroin-A+as+a+potential+inhibitor+of+SARS-CoV-2&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Molecular+docking+and+dynamics+studies+on+propolis+sulabiroin-A+as+a+potential+inhibitor+of+SARS-CoV-2&btnG=
https://www.frontiersin.org/journals/pharmacology/articles/10.3389/fphar.2021.799448/full
https://www.frontiersin.org/journals/pharmacology/articles/10.3389/fphar.2021.799448/full
https://www.frontiersin.org/journals/pharmacology/articles/10.3389/fphar.2021.799448/full
https://www.frontiersin.org/journals/pharmacology/articles/10.3389/fphar.2021.799448/full
https://www.frontiersin.org/journals/pharmacology/articles/10.3389/fphar.2021.799448/full
https://www.mdpi.com/2227-9717/10/11/2340
https://www.mdpi.com/2227-9717/10/11/2340
https://www.mdpi.com/2227-9717/10/11/2340
https://www.mdpi.com/2227-9717/10/11/2340
https://www.mdpi.com/2227-9717/10/11/2340
https://www.nature.com/articles/s41598-021-86914-8
https://www.nature.com/articles/s41598-021-86914-8
https://www.nature.com/articles/s41598-021-86914-8
https://www.nature.com/articles/s41598-021-86914-8
https://www.mdpi.com/1420-3049/27/13/4057
https://www.mdpi.com/1420-3049/27/13/4057
https://www.mdpi.com/1420-3049/27/13/4057
https://www.mdpi.com/1420-3049/27/13/4057
https://www.mdpi.com/1420-3049/27/13/4057
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.tandfonline.com/doi/abs/10.1080/07391102.2020.1798285
https://www.tandfonline.com/doi/abs/10.1080/07391102.2020.1798285
https://www.tandfonline.com/doi/abs/10.1080/07391102.2020.1798285
https://www.tandfonline.com/doi/abs/10.1080/07391102.2020.1798285
https://www.tandfonline.com/doi/abs/10.1080/07391102.2020.1798285
https://www.tandfonline.com/doi/abs/10.1080/07391102.2020.1798285
https://link.springer.com/article/10.1016/j.jsps.2022.04.003
https://link.springer.com/article/10.1016/j.jsps.2022.04.003
https://link.springer.com/article/10.1016/j.jsps.2022.04.003
https://link.springer.com/article/10.1016/j.jsps.2022.04.003
https://link.springer.com/article/10.1016/j.jsps.2022.04.003
https://link.springer.com/article/10.1016/j.jsps.2022.04.003
https://link.springer.com/article/10.1016/j.jsps.2022.04.003
https://link.springer.com/article/10.1016/j.jsps.2022.04.003
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Benchmarked+molecular+docking+integrated+molecular+dynamics+stability+analysis+for+prediction+of+SARS-CoV-2+papain-like+protease+inhibition+by+olive+secoiridoids.&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Benchmarked+molecular+docking+integrated+molecular+dynamics+stability+analysis+for+prediction+of+SARS-CoV-2+papain-like+protease+inhibition+by+olive+secoiridoids.&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Benchmarked+molecular+docking+integrated+molecular+dynamics+stability+analysis+for+prediction+of+SARS-CoV-2+papain-like+protease+inhibition+by+olive+secoiridoids.&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Benchmarked+molecular+docking+integrated+molecular+dynamics+stability+analysis+for+prediction+of+SARS-CoV-2+papain-like+protease+inhibition+by+olive+secoiridoids.&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Benchmarked+molecular+docking+integrated+molecular+dynamics+stability+analysis+for+prediction+of+SARS-CoV-2+papain-like+protease+inhibition+by+olive+secoiridoids.&btnG=
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://www.sciencedirect.com/science/article/pii/S0254629921004798


Advances in Pharmacology and Clinical Trials
33

Mujeebuddin CS and Suresh. Investigate the Anticonvulsant and Neuroprotective Effects of 
Commercially Available Humid Acid by Utilizing both In Silico and In Vitro Approaches. Adv in 
Phar & Clin Tria 2026, 11(1): 000259.

Copyright©  Mujeebuddin CS and Suresh.

South African Journal of Botany 151: 82-91. 

48.	 He F, Wang X, Wu Q, Liu S, Cao Y, et al. (2023) Identification 
of potential ATP-competitive cyclin-dependent kinase 1 
inhibitors: De novo drug generation, molecular docking, 
and molecular dynamics simulation. Comput Biol Med 
155

49.	 Fatriansyah JF, Rizqillah RK, Yandi MY, Fadilah, Sahlan 
M (2022) Molecular docking and dynamics studies on 
propolis sulabiroin-A as a potential inhibitor of SARS-
CoV-2. J King Saud Univ Sci 34(1). 

50.	 Hasan MM, Khan Z, Chowdhury MS, Khan MA, Moni MA, 
et al. (2022) In silico molecular docking and ADME/T 
analysis of Quercetin compound with its evaluation 
of broad-spectrum therapeutic potential against 
particular diseases. Inform Med Unlocked. 29. 

51.	 He F, Wang X, Wu Q, Liu S, Cao Y, et al. (2023) Identification 
of potential ATP-competitive cyclin-dependent kinase 1 
inhibitors: De novo drug generation, molecular docking, 
and molecular dynamics simulation. Comput Biol Med 
155. 

52.	 Obaidullah AJ, Alanazi MM, Alsaif NA, Alanazi AS, 
Albassam H, et al. (2022) Network Pharmacology- 
and Molecular Docking-Based Identification of 
Potential Phytocompounds from Argyreia capitiformis 
in the Treatment of Inflammation. Evidence-based 
Complementary and Alternative Medicine 2022.

53.	  Jupudi S, Rajagopal K, Murugesan S, Kumar BK, Raman 
K, et al. (2022) Identification of Papain-Like Protease 
inhibitors of SARS CoV-2 through HTVS, Molecular 
docking, MMGBSA and Molecular dynamics approach. 
South African Journal of Botany 151: 82-91. 

54.	  Chandran U, Mehendale N, Patil S, Chaguturu R, 
Patwardhan B et al. (2017) Network Pharmacology. 
In: Innovative Approaches in Drug Discovery: 
Ethnopharmacology, Systems Biology and Holistic 
Targeting. Elsevier Inc. p. 127-64.

55.	  Kumar S, Kumar D, Deshmukh RR, Lokhande PD, More 
SN, et al. (2008) Antidiabetic potential of Phyllanthus 
reticulatus in alloxan-induced diabetic mice. Fitoterapia 
79 (1): 21-23. 

56.	  Omulokoli E, Khan B, Chhabra SC (1997) Antiplasmodial 
activity of four Kenyan medicinal plants. Journal of 
Ethnopharmacology 56 (2): 133-7. 

57.	 Maruthappan V, Sakthi KS (2010) Effects of Phyllanthus 
reticulatus on lipid profile and oxidative stress in 
hypercholesterolemic albino rats. Indian Journal of 

Pharmacology 42 (6): 388-391. 

58.	 Begum T, Rahman SM, Rashid AM (2006) Phytochemical 
and Biological Investigations of Phyllanthus reticulatus. 
Dhaka University Journal of Pharmaceutical Sciences 5 
(1-2): 21-23. 

59.	 Das KB, Bepary S, Datta KB, Chowdhury Azad AAK, Ali, 
et al. (2008) Hepatoprotective activity of Phyllanthus 
reticulatus. Pakistan Journal of Pharmaceutical Sciences 
21(4): 333-337. 

60.	 Shruthi SD, Ramachandra YL, Padmalatha RS, Shettty 
VA (2010) Antibacterial potential of leaf extracts 
from Kirganelia reticulate Baill. International Journal 
of Pharmaceutical Research and Development 2 (6): 
0974-9446. 

61.	 Rahmatullah M, Ghosh KC, Almamun A, Hossain MT, 
Ahmed SA, et al. (2010) pharmacological study on 
Antinociceptive and Anti-hyperglycemic effects of 
methanol extract of leaves of Phyllanthus reticulates 
Poir. In swiss albino mice. Advances in Natural and 
Applied Sciences 4 (3): 229-232. 

62.	 Saha A, Masud AM, Bachar CS, Kundu KJ, Datta KB, et al. 
(2007) The analgesic and anti-inflammatory activities 
of extracts of Phyllanthus reticulatus in mice model. 
Pharmaceutical Biology 45 (5): 335-359. 

63.	 Maruthappan V, Shree KS (2010) A report on the 
antioxidant activity of the powder of the entire plant 
of Phyllanthus reticulatus Poir. Indian Journal of 
Pharmacology 4(4): 265-269. 

64.	 Das BP, Mohammad S, Pavel AM, Bhattacharjee R, Das B, 
et al. (2011) Anti-hepatitis B viral activity of Phyllanthus 
reticulatus. Bangladesh Pharmaceutical Journal 14 (1): 
11-14. 

65.	 Saleh-E-In MM, Kar P, Roy A, Kowalski R (2022) 
Phytochemical account: Phyllanthus reticulatus Poir. J 
Phytomol Pharmacol 1(1): 19-29.

66.	 Hopkins AL (2008) Network pharmacology: The next 
paradigm in drug discovery. Nature Chemical Biology. 
Nature Publishing Group 4: 682-690. 

67.	 Chandran U, Mehendale N, Patil S, Chaguturu R, 
Patwardhan B et al. (2017) Network Pharmacology. 
In: Innovative Approaches in Drug Discovery: 
Ethnopharmacology, Systems Biology and Holistic 
Targeting. Elsevier Inc 127-164. 

68.	 Olsen RW, Tobin AJ (1990) Molecular biology of GABAA 
receptors. The FASEB Journal 4(5): 1469-1480.

https://medwinpublishers.com/APCT/
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=%29+Molecular+docking+and+dynamics+studies+on+propolis+sulabiroin-A+as+a+potential+inhibitor+of+SARS-CoV-2.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=%29+Molecular+docking+and+dynamics+studies+on+propolis+sulabiroin-A+as+a+potential+inhibitor+of+SARS-CoV-2.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=%29+Molecular+docking+and+dynamics+studies+on+propolis+sulabiroin-A+as+a+potential+inhibitor+of+SARS-CoV-2.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=%29+Molecular+docking+and+dynamics+studies+on+propolis+sulabiroin-A+as+a+potential+inhibitor+of+SARS-CoV-2.+&btnG=
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S2352914822000466
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://www.sciencedirect.com/science/article/pii/S0010482523001105
https://onlinelibrary.wiley.com/doi/full/10.1155/2022/8037488
https://onlinelibrary.wiley.com/doi/full/10.1155/2022/8037488
https://onlinelibrary.wiley.com/doi/full/10.1155/2022/8037488
https://onlinelibrary.wiley.com/doi/full/10.1155/2022/8037488
https://onlinelibrary.wiley.com/doi/full/10.1155/2022/8037488
https://onlinelibrary.wiley.com/doi/full/10.1155/2022/8037488
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://www.sciencedirect.com/science/article/pii/S0254629921004798
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antidiabetic+potential+of+Phyllanthus+reticulatus+in+alloxan-induced+diabetic+mice&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antidiabetic+potential+of+Phyllanthus+reticulatus+in+alloxan-induced+diabetic+mice&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antidiabetic+potential+of+Phyllanthus+reticulatus+in+alloxan-induced+diabetic+mice&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Antidiabetic+potential+of+Phyllanthus+reticulatus+in+alloxan-induced+diabetic+mice&btnG=
https://www.sciencedirect.com/science/article/abs/pii/S0378874197015213
https://www.sciencedirect.com/science/article/abs/pii/S0378874197015213
https://www.sciencedirect.com/science/article/abs/pii/S0378874197015213
https://www.ovid.com/jnls/iphr/fulltext/10.4103/0253-7613.71923~effects-of-phyllanthus-reticulatus-on-lipid-profile-and
https://www.ovid.com/jnls/iphr/fulltext/10.4103/0253-7613.71923~effects-of-phyllanthus-reticulatus-on-lipid-profile-and
https://www.ovid.com/jnls/iphr/fulltext/10.4103/0253-7613.71923~effects-of-phyllanthus-reticulatus-on-lipid-profile-and
https://www.ovid.com/jnls/iphr/fulltext/10.4103/0253-7613.71923~effects-of-phyllanthus-reticulatus-on-lipid-profile-and
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Phytochemical+and+Biological+Investigations+of+Phyllanthus+reticulatus.&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Phytochemical+and+Biological+Investigations+of+Phyllanthus+reticulatus.&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Phytochemical+and+Biological+Investigations+of+Phyllanthus+reticulatus.&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Phytochemical+and+Biological+Investigations+of+Phyllanthus+reticulatus.&btnG=
https://www.researchgate.net/profile/Biplab-Das-2/publication/23394458_Hepatoprotective_activity_of_Phyllanthus_Reticulatus/links/09e41505ab91845588000000/Hepatoprotective-activity-of-Phyllanthus-Reticulatus.pdf
https://www.researchgate.net/profile/Biplab-Das-2/publication/23394458_Hepatoprotective_activity_of_Phyllanthus_Reticulatus/links/09e41505ab91845588000000/Hepatoprotective-activity-of-Phyllanthus-Reticulatus.pdf
https://www.researchgate.net/profile/Biplab-Das-2/publication/23394458_Hepatoprotective_activity_of_Phyllanthus_Reticulatus/links/09e41505ab91845588000000/Hepatoprotective-activity-of-Phyllanthus-Reticulatus.pdf
https://www.researchgate.net/profile/Biplab-Das-2/publication/23394458_Hepatoprotective_activity_of_Phyllanthus_Reticulatus/links/09e41505ab91845588000000/Hepatoprotective-activity-of-Phyllanthus-Reticulatus.pdf
https://www.researchgate.net/profile/Y-L-Ramachandra/publication/292798434_Antibacterial_potential_of_leaf_extracts_from_Kirganelia_reticulata_Baill/links/581b15c108aeccc08aea2e8a/Antibacterial-potential-of-leaf-extracts-from-Kirganelia-reticulata-Baill.pdf
https://www.researchgate.net/profile/Y-L-Ramachandra/publication/292798434_Antibacterial_potential_of_leaf_extracts_from_Kirganelia_reticulata_Baill/links/581b15c108aeccc08aea2e8a/Antibacterial-potential-of-leaf-extracts-from-Kirganelia-reticulata-Baill.pdf
https://www.researchgate.net/profile/Y-L-Ramachandra/publication/292798434_Antibacterial_potential_of_leaf_extracts_from_Kirganelia_reticulata_Baill/links/581b15c108aeccc08aea2e8a/Antibacterial-potential-of-leaf-extracts-from-Kirganelia-reticulata-Baill.pdf
https://www.researchgate.net/profile/Y-L-Ramachandra/publication/292798434_Antibacterial_potential_of_leaf_extracts_from_Kirganelia_reticulata_Baill/links/581b15c108aeccc08aea2e8a/Antibacterial-potential-of-leaf-extracts-from-Kirganelia-reticulata-Baill.pdf
https://www.researchgate.net/profile/Y-L-Ramachandra/publication/292798434_Antibacterial_potential_of_leaf_extracts_from_Kirganelia_reticulata_Baill/links/581b15c108aeccc08aea2e8a/Antibacterial-potential-of-leaf-extracts-from-Kirganelia-reticulata-Baill.pdf
https://www.academia.edu/30512311/A_Pharmacological_Study_on_Antinociceptive_and_Anti_hyperglycemic_Effects_of_Methanol_Extract_of_Leaves_of_Phyllanthus_Reticulatus_Poir_In_Swiss_Albino_Mice
https://www.academia.edu/30512311/A_Pharmacological_Study_on_Antinociceptive_and_Anti_hyperglycemic_Effects_of_Methanol_Extract_of_Leaves_of_Phyllanthus_Reticulatus_Poir_In_Swiss_Albino_Mice
https://www.academia.edu/30512311/A_Pharmacological_Study_on_Antinociceptive_and_Anti_hyperglycemic_Effects_of_Methanol_Extract_of_Leaves_of_Phyllanthus_Reticulatus_Poir_In_Swiss_Albino_Mice
https://www.academia.edu/30512311/A_Pharmacological_Study_on_Antinociceptive_and_Anti_hyperglycemic_Effects_of_Methanol_Extract_of_Leaves_of_Phyllanthus_Reticulatus_Poir_In_Swiss_Albino_Mice
https://www.academia.edu/30512311/A_Pharmacological_Study_on_Antinociceptive_and_Anti_hyperglycemic_Effects_of_Methanol_Extract_of_Leaves_of_Phyllanthus_Reticulatus_Poir_In_Swiss_Albino_Mice
https://www.academia.edu/30512311/A_Pharmacological_Study_on_Antinociceptive_and_Anti_hyperglycemic_Effects_of_Methanol_Extract_of_Leaves_of_Phyllanthus_Reticulatus_Poir_In_Swiss_Albino_Mice
https://www.tandfonline.com/doi/full/10.1080/13880200701212973
https://www.tandfonline.com/doi/full/10.1080/13880200701212973
https://www.tandfonline.com/doi/full/10.1080/13880200701212973
https://www.tandfonline.com/doi/full/10.1080/13880200701212973
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=A+report+on+the+antioxidant+activity+of+the+powder+of+the+entire+plant+of+Phyllanthus+reticulatus+Poir.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=A+report+on+the+antioxidant+activity+of+the+powder+of+the+entire+plant+of+Phyllanthus+reticulatus+Poir.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=A+report+on+the+antioxidant+activity+of+the+powder+of+the+entire+plant+of+Phyllanthus+reticulatus+Poir.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=A+report+on+the+antioxidant+activity+of+the+powder+of+the+entire+plant+of+Phyllanthus+reticulatus+Poir.+&btnG=
https://www.researchgate.net/profile/Jma-Hannan/publication/268381328_Anti_Hepatitis_B_Viral_Activity_of_Phyllanthus_reticulatus/links/54dde3770cf23bf20438de7f/Anti-Hepatitis-B-Viral-Activity-of-Phyllanthus-reticulatus.pdf
https://www.researchgate.net/profile/Jma-Hannan/publication/268381328_Anti_Hepatitis_B_Viral_Activity_of_Phyllanthus_reticulatus/links/54dde3770cf23bf20438de7f/Anti-Hepatitis-B-Viral-Activity-of-Phyllanthus-reticulatus.pdf
https://www.researchgate.net/profile/Jma-Hannan/publication/268381328_Anti_Hepatitis_B_Viral_Activity_of_Phyllanthus_reticulatus/links/54dde3770cf23bf20438de7f/Anti-Hepatitis-B-Viral-Activity-of-Phyllanthus-reticulatus.pdf
https://www.researchgate.net/profile/Jma-Hannan/publication/268381328_Anti_Hepatitis_B_Viral_Activity_of_Phyllanthus_reticulatus/links/54dde3770cf23bf20438de7f/Anti-Hepatitis-B-Viral-Activity-of-Phyllanthus-reticulatus.pdf
https://leafletpub.com/images/articlesFile/1697130250.pdf
https://leafletpub.com/images/articlesFile/1697130250.pdf
https://leafletpub.com/images/articlesFile/1697130250.pdf
https://www.nature.com/articles/nchembio.118
https://www.nature.com/articles/nchembio.118
https://www.nature.com/articles/nchembio.118
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://scholar.google.com/scholar?hl=en&as_sdt=0%2C5&q=Network+Pharmacology.+In%3A+Innovative+Approaches+in+Drug+Discovery%3A+Ethnopharmacology%2C+Systems+Biology+and+Holistic+Targeting.+&btnG=
https://faseb.onlinelibrary.wiley.com/doi/abs/10.1096/fasebj.4.5.2155149
https://faseb.onlinelibrary.wiley.com/doi/abs/10.1096/fasebj.4.5.2155149


Advances in Pharmacology and Clinical Trials
34

Mujeebuddin CS and Suresh. Investigate the Anticonvulsant and Neuroprotective Effects of 
Commercially Available Humid Acid by Utilizing both In Silico and In Vitro Approaches. Adv in 
Phar & Clin Tria 2026, 11(1): 000259.

Copyright©  Mujeebuddin CS and Suresh.

69.	 Mehta AK, Ticku MK (1999) An update on GABAA 
receptors. Brain research reviews 29(2-3): 196-217.

70.	 Macdonald RL, Olsen RW (1994) GABAA receptor 
channels. Annual review of neuroscience 17(1): 569-
602.

71.	 Olsen RW, Sieghart W (2009) GABAA receptors: subtypes 
provide diversity of function and pharmacology. 

Neuropharmacology 56(1): 141-148.

72.	 Mody I, Pearce RA (2004) Diversity of inhibitory 
neurotransmission through GABAA receptors. Trends 
in neurosciences 27(9): 569-575.

73.	 Lobo IA, Harris RA (2008) GABAA receptors and alcohol. 
Pharmacology Biochemistry and Behavior 90(1): 91-94

https://medwinpublishers.com/APCT/
https://www.sciencedirect.com/science/article/abs/pii/S0165017398000526
https://www.sciencedirect.com/science/article/abs/pii/S0165017398000526
https://www.annualreviews.org/content/journals/10.1146/annurev.ne.17.030194.003033
https://www.annualreviews.org/content/journals/10.1146/annurev.ne.17.030194.003033
https://www.annualreviews.org/content/journals/10.1146/annurev.ne.17.030194.003033
https://www.sciencedirect.com/science/article/abs/pii/S0028390808003377
https://www.sciencedirect.com/science/article/abs/pii/S0028390808003377
https://www.sciencedirect.com/science/article/abs/pii/S0028390808003377
https://www.cell.com/trends/neurosciences/abstract/S0166-2236(04)00227-9
https://www.cell.com/trends/neurosciences/abstract/S0166-2236(04)00227-9
https://www.cell.com/trends/neurosciences/abstract/S0166-2236(04)00227-9
https://www.sciencedirect.com/science/article/abs/pii/S0091305708000750
https://www.sciencedirect.com/science/article/abs/pii/S0091305708000750

	RANGE!A1
	_Hlk163206868
	Introduction
	Statement of The Problem 
	Definitions
	Theoretical Basis 
	Experimental models 
	Purpose of The Study 
	Anxiety
	Antianxiety Drugs:

	Review of Literature
	Epilepsy 
	Nature of Epilepsy 
	Types
	Causes 
	Genetic Factors 
	Other Disorders 
	Head Injury, Prenatal Injury and Developmental Problems 
	Poisoning 
	Symptoms 
	Syndromes 
	Pathophysiology 
	Diagnosis 
	Treatment 
	Medications 
	Classification 
	Mechanism of Action 
	Surgery to Treat Underlying Conditions 
	Surgery to Remove a Seizure Focus
	Indications of Surgery 
	Contraindications of Surgery 
	Multiple Subpial Transection 
	Corpus Callosotomy 
	Hemispherectomy and Hemispherotomy 
	Devices 
	Diet 

	Antiepilepsy Activity
	Avanthi E et al., (2016) 
	K Sandeep Kumar et al., (2015) 
	Nirmala D (2015) 
	Gummalla Pitchaiahet al., (2015) 
	Santilna K S et al., (2014) 
	Ravindra C Sutar et al., (2014) 
	Dilnawaz Pathan et al., (2014) 
	Ganapathi G. Varmaet al., (2014) 
	Abubakar K et al., (2013) 
	Ashish P Anovadiya et al., (2013) 
	Prabhat Singh et al., (2012)
	Vikas Saroch et al., (2012)
	Vipin K Garget al., (2011)
	Shyamjith Manikkoth et al., (2011) 
	Harish Babu B et al., (2010) 
	N. S. Vyawahareet al., (2009) 
	KarunakarHegde et al., (2009)

	Scope and Plan of Work
	Aim
	Objectives
	Plan of Work

	Materials & Methods
	Plant Profile
	Collection of Botanicals and Their Phytochemicals
	ADME Screening of Identified Phytochemicals 
	Screening of Target and Disease Proteins
	Identification of Common Targets
	Analysis of Protein-Protein Interaction
	Topological Analysis
	Gene Ontology (Go) Enrichment Analysis
	Molecular Docking & Molecular Simulation Dynamics Studies
	MMGBSA
	Molecular Dynamics

	Results
	Identification of Botanicals and Retrieval of Their Active Constituents
	ADME Properties Using Qikprop 
	Identification of Phyto-Targets and Disease Targets
	Identification of Common Targets
	Building of the Target Network 
	Topological Analysis
	Gene Ontology (GO) Enrichment Analysis 
	Pathway Analysis
	Molecular Docking
	MM/GBSA 
	Molecular Dynamics

	Discussion
	Conclusion 
	References

